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Chapter 1. Sterling Gentran:Server HIPAA Support Features

About Support for HIPAA in Sterling Gentran:Server
The Health Insurance Portability and Accountability Act of 1996 (HIPAA) requires
that various health care plans, and health care providers and clearinghouses meet
certain data security and other types of mandates for electronic health care
transactions.

Your IBM® Sterling Gentran:Server® for Microsoft Windows product provides
features to help you meet HIPAA requirements. These are the Sterling
Gentran:Server compliance features:
v Support for the electronic data interchange standards that HIPAA requires
v Provision for automatic logoff
v Provision for emergency access to the system

Note: To comply with the HIPAA mandates listed above, you must implement the
features as described in this document. You will not be in compliance if you
bypass or modify these features.

Activating HIPAA features

When you install Sterling Gentran:Server for Microsoft Windows, you must choose
the HIPAA compliance option to activate the HIPAA features in the product.

Supported standards

Sterling Gentran:Server supports the national electronic data interchange (EDI)
standards for electronic health care transactions adopted in HIPAA. These are:
v ANSI ASC X12N standards, Version 4010, for all transactions except retail

pharmacy transactions. Certain ASC X12 transaction sets include binary
segments. Sterling Gentran:Server is able to process binary segments that are
part of a supported standard.

v NCPDP Telecommunications Standard, Version 5.1 (batch version). Sterling
Gentran:Server is able to process repeating elements that are part of this
standard.

Automatic logoff

The Health Insurance Portability and Accountability Act (HIPAA) requires software
systems that display patient information to automatically exit when not in use. The
purpose of this requirement is to prevent unauthorized persons from viewing and
gaining access to the system.

When you use Sterling Gentran:Server for Microsoft Windows and choose to be
HIPAA compliant, you must have a screen saver enabled with password
protection, or you will not be able to log on to the Sterling Gentran:Server system.

© Copyright IBM Corp. 1996, 2012 1



Emergency access

HIPAA requires emergency access to patient information, which is to be used in
emergency cases where quick, direct access is required. This emergency access is
commonly referred to as a “back door” into the system.

The installation of Sterling Gentran:Server for Microsoft Windows requires you to
supply a known username/password combination, which you must then note and
store in a secure location. This username/password combination is the emergency
access user.

Setting up Security
When you use Sterling Gentran:Server for Microsoft Windows and choose to be
HIPAA compliant, you must have a screen saver enabled with password
protection, or you will not be able to log on to the Sterling Gentran:Server system.

About this task

You are not HIPAA compliant and Sterling Gentran:Server (with the HIPAA
compliance option activated) will not execute on systems that do not have a screen
saver configured with password protection.

Use this procedure to set up security.

Procedure
1. When you install your Sterling Gentran:Server for Microsoft Windows software,

select the HIPAA compliance option. See the Installation Guide for instructions.
2. Configure your system’s screen saver to protect your files.

v Select a screen saver
v Enable the password protection option and set a password for the screen

saver
v Select the number of minutes your computer can remain idle before it

displays the password-protected screen saver.
See your Microsoft Windows documentation and online help system for
instructions on configuring these settings.

System Checks
Because you chose the HIPAA compliance option during installation, Sterling
Gentran:Server will verify that you have set your computer’s screen saver option
with a password when you start certain programs.

If the screen saver with password is not set, the system blocks your access to
programs capable of displaying patient information, such as the EDI Manager.
Sterling Gentran:Server displays a message to remind you that you must set the
screen saver option with a password.

If you turn off the screen saver with password option after you start Sterling
Gentran:Server, the system halts and displays a reminder message. You cannot
resume until you turn on the screen saver with password.

2 IBM Sterling Gentran:Server for Windows: HIPAA and NCPDP Compliance Guide



Regaining access

This table shows how to regain access to your system when you have security
settings enabled.

If... Then... And you must...

The Microsoft Windows
screen saver with
password option is turned
off when you start
Sterling Gentran:Server

Sterling Gentran:Server displays an
error message and prevents access.

enable the Microsoft
Windows screen saver
with password option to
gain access.

You turn off the screen
saver with password
option after you start
Sterling Gentran:Server

Sterling Gentran:Server freezes
activity and displays an error
message.

enable the screen saver
with password option to
continue.

When the time-out value
set in your screen saver
expires

your computer monitor displays
the screen saver configured for
your computer along with a
password dialog box.

type the password
specified for your screen
saver into the dialog box
and click OK.

How to Access Sterling Gentran:Server in an Emergency
This topic explains what to do in the event your Sterling Gentran:Server security
administrator is unavailable or unable to access the system in an emergency
situation.

To gain access to Sterling Gentran:Server in an emergency, you must call an IBM
support representative and explain the situation. The support representative will
provide a solution.

Chapter 1. Sterling Gentran:Server HIPAA Support Features 3
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Chapter 2. Using NCPDP with Sterling Gentran:Server

Separator Characters
The specific separator characters used to distinguish groups, segments, and fields
are fixed in the NCPDP Standard.

This table lists the separator characters.

Level of
Separator

Decimal
Representation

Hex
Representation Comment

Segment 30 1E Separates segments from each other

Group 29 1D Separates groups from each other

Field 28 1C Separates fields from each other

This example shows how separators are used in an NCPDP transaction.
61006650B112345678901074563663bbbbbbbb19970920bbbbbbbbb<1E><1C>AM04<1C>
C2987654321<1E><1C>AM01<1C>CX01<1C>CY123456789<1C>C419620615<1C>C51<1C>
CAJOSEPH<1C>CBSMITH<1C>CM123 MAIN STREET<1C>CNMY TOWN<1C>COCO<1C>CP34567

Supported NCPDP Version and Transactions
Sterling Gentran:Server supports version 5.1 of the NCPDP Telecommunications
Standard.

This table lists the NCPDP 5.1 transactions that Sterling Gentran:Server supports.

Transaction
Code Transaction Name

E1 Eligibility Verification

B1 Billing

B2 Reversal

B3 Rebill

P1 Prior Authorization Request and Billing

P2 Prior Authorization Reversal

P3 Prior Authorization Inquiry

P4 Prior Authorization Request Only

N1 Information Reporting

N2 Information Reporting Reversal

N3 Information Reporting Rebill

C1 Controlled Substance Reporting

C2 Controlled Substance Reporting Reversal

C3 Controlled Substance Reporting Reversal

© Copyright IBM Corp. 1996, 2012 5



Transaction Types: Requests and Responses
The NCPDP standard has two main types of transactions - requests and responses.
v Requests are claim transactions that a pharmacy or other provider submits to an

insurer or other processor.
v Responses are replies to request transactions.

Structure of a request

This is the basic structure of a request:
v Header segment (for a request)
v Patient segment
v Insurance segment
v Transaction group (up to four per transmission for transaction codes B1-B3,

except for compounds, N1-N3, and C1-C3)
– Claim segment
– Pharmacy Provider segment
– Prescriber segment
– Coordination of benefits/Other payments segment
– Workers’ compensation segment
– DUR/PPS segment
– Pricing segment
– Coupon segment
– Compound segment
– Prior authorization segment
– Clinical segment

Structure of a response

This is the basic structure of a response:
v Header segment (for a response)
v Message segment (for a response)
v Insurance segment (for a response)
v Transaction response (up to four per transmission)
v Response Status Group

– Response Claim segment
– Response Pricing segment
– Response DUR/PPS segment
– Response Prior Authorization segment

Note: A response transmission contains an NCPDP response transaction for each
request transaction received.

NCPDP Transaction Syntax
Transactions are a collection of segments separated by Segment separator
characters. Transactions are separated within a transmission with a group separator
character.

6 IBM Sterling Gentran:Server for Windows: HIPAA and NCPDP Compliance Guide



Transaction syntax

This is an example of the syntax of a billing request transaction:

Transaction header segment
v Transaction header fields. Fixed-length without field separators. In this segment,

each data element is transmitted at its maximum length positionally.

Segment separator

Insurance segment
v Required fields within segment, with field separators
v Optional fields within segment, with field separators

Segment separator

Patient segment
v Required fields within segment, with field separators
v Optional fields within segment, with field separators

Group separator

Segment separator

Claim segment
v Required fields within segment, with field separators
v Optional fields within segment, with field separators

Segment separator

Pricing segment
v Required fields within segment, with field separators
v Optional fields within segment, with field separators

Truncation

Sterling Gentran:Server provides the ability to truncate delimited data elements. If
your trading partner accepts variable-length fields, you can use truncation to
suppress leading zeros in numeric fields and trailing spaces in alphanumeric fields.
Truncation helps decrease transmission time.

Five Key Fields for Trading Partnership Code
For inbound translation, Sterling Gentran:Server looks for the values of five key
fields in the transaction to determine the Trading Partnership code in an NCPDP
batch transaction.

This table lists the five key fields and their locations.

Key Field Location

Sender ID Batch transaction header

Version/Release Number Transaction header segment
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Key Field Location

Transaction Code Batch header segment

Test Production Batch header segment

Note: The agency is hardcoded as "D".

See Batch Transaction Header for the layout of the header. See Request Transaction
Header Segment and Response Transaction Header Segment for the layout of the
transaction header segments.

About NCPDP Batch Transmissions
Sterling Gentran:Server transmits NCPDP transactions in batch mode, using the
NCPDP Batch Transaction Standard format.

The NCPDP Batch Transaction Standard is a standardized file submission format
that enables organizations to submit electronic pharmacy transactions in a
non-real-time mode.

An NCPDP batch transaction has a uniform format that begins with a batch
transaction header segment and ends with a trailer segment. The actual
transactions are arranged in detail data records between these two segments.

For example: A pharmacy submitting claims to an insurer sends a batch file that
contains one batch transaction header, a detail data record for each claim, and one
batch trailer segment.

Parts of an NCPDP Batch Transmission
There are three parts (records) in an NCPDP batch transmission:
v Batch Transaction Header Segment (segment identifier = 00)
v One or more Batch Detail Data Records (segment identifier = G1)
v Batch Trailer Segment (segment identifier = 99)

Each part begins with a start-of-text STX field (hex02) and ends with an end-of-text
ETX field (hex03). The Start- and End-of-text fields are also used to delimit the
detail data records within the file.

For example, the following contains a batch header record, two incomplete detail
data records, and a batch trailer record. The segment identifiers are in boldface
type.
(STX)00T1289012345673674589022229876747199412011632T11DEABGHCFYTEWQASDXZAQ3124(ETX)
(STX)G110000543219999993201..............(ETX)
(STX)G110000543229999993201..............(ETX)
(STX)9948767470000000004initial Test....(ETX)

A batch transmission that does not have a detail data record is considered a
response to a batch file error. A batch file error indicates that an entire batch file
was rejected, usually because the file failed the processor’s file integrity test.

For example, if the record counts in the header segment and the trailer segment do
not match, the result is a batch file error.
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Batch Transaction Header Segment
Each batch file has one batch transaction header segment.

The batch transaction header is a positional (fixed-length non-delimited) segment,
75 characters in length.

The header contains information that identifies the batch file. This information
includes:
v Segment identifier
v Batch Number field that contains the same value as the Batch Number field in

the batch trailer segment
v Creation date
v Creation time
v Sender ID
v Receiver ID

See Batch Transaction Header for a description of the fields in the batch transaction
header.

The Sender ID, version, release, and test/production in the batch transaction
header are four of the five key fields used to determine the Trading Partnership
code. The remaining key fields are in the Transaction Header Segment of the batch
detail data record.

See Five Key Fields for Trading Partnership Code for a complete list.

Batch Detail Data Record
A batch file contains one detail data record for each request or response
transmission.

A batch detail data record contains an actual NCPDP transmission. Each detail
data record transmitted in the batch file must follow the format defined for the
transaction in the NCPDP Telecommunication Standard.
v Detail data records contain both fixed-length (positional) and variable-length

fields.
v A batch transmission can have up to 9,999,999,997 detail data records per file.
v Each batch detail data record contains a Transaction Header Segment to identify

the transaction set. The transaction header segment for the set begins in position
14 of a detail data record.

See Batch Detail Data Record for a description of the fields in the batch detail data
record.

Transaction Header Segment
Each detail data record in a batch file has one transaction header segment that
identifies the transaction.

The transaction header segment:
v Specifies the NCPDP version number
v Identifies the type of transaction
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Examples:
E1 for eligibility verification
B1 for a billing transaction

v Contains one of the five key fields that Sterling Gentran:Server uses to
determine the Trading Partnership code for inbound translation.

The Transaction Code is the only key field in the transaction header segment that
Sterling Gentran:Server uses to find the Trading Partnership code:
v

The structure of the transaction header segment indicates whether the transaction
is a request or response.
v A Request Transaction Header Segment is a fixed-length 56-character segment

containing 9 fields.
v A Response Transaction Header segment is a fixed-length 31-character segment

containing 7 fields.

The transaction header segment is the only segment that does not have a segment
identifier. The Transaction Code field in this segment is used to identify the
transaction.

See Request Transaction Header Segment for a description of the fields in a
Request Transaction Header segment. See Response Transaction Header Segment
for a description of the fields in a Response Transaction Header segment.

Batch Trailer Segment
Each batch file has one trailer segment. The trailer segment ends the batch file.

The batch trailer segment is a positional segment with a length of 56 characters.

The trailer segment contains a Batch Number field that must have the same value
as the Batch Number field in the batch transaction header segment.

See Batch Trailer Record or a description of the fields in the batch detail data
record.
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Chapter 3. Creating NCPDP Maps

The NCPDP Standard DDFs
The Standards DVD supplied with your Sterling Gentran:Server for Microsoft
Windows product has a folder that contains translation objects for creating NCPDP
data definition files (DDFs).

IBM provides these DDFs to help you develop your NCPDP maps quickly and
efficiently.

The NCPDP transactions exist only in the NCPDP DDFs; they are not in the
Standards database on the Standards DVD.

Each NCPDP DDF contains:
v All standard components for the NCPDP transaction (such as B1, B2, B3)
v The standard components required for batch transmissions (batch header, batch

trailer)

Copying the NCPDP DDFs
We recommend that you copy the folder that contains the NCPDP data definition
files to a subdirectory in the folder that holds your file definitions (*.DDF files) so
that you can access them when you need them.

About this task

Use this procedure to copy the NCPDP DDF folder.

Procedure
1. Insert the Standards DVD into the drive on your machine.
2. Locate the NCPDP DDF folder on the DVD.
3. Copy the folder from the Standards DVD to the destination directory.

NCPDP Translation Set up Process
This table lists the stages in the process to set up your system to translate NCPDP
data.

Stage Description

1 Analyze the format of the NCPDP data. See Analyzing the NCPDP Data.

2 Create the NCPDP map. See Creating an Inbound NCPDP Map or Creating
an Outbound NCPDP Map.

3 Define the input and output sides of the map. See the section on Structuring
an NCPDP Map for instructions on structuring the NCPDP side of the map.
See the Sterling Gentran:Server Application Integration User Guide for
instructions on structuring the side of the map that is not an NCPDP
format.

4 Create the NCPDP trading partner profile. See the section on Using Partner
Editor with NCPDP for instructions.

© Copyright IBM Corp. 1996, 2012 11



Stage Description

5 Set translation options for NCPDP data. See the Sterling Gentran:Server
Application Integration User Guide for instructions.

Analyzing the NCPDP Data
Before you begin

Before you can create a map to translate data into a NCPDP standard format, you
must analyze the NCPDP format that you want to use in the map. You will use the
information you gather to create a Data Definition Format (DDF) file that defines
the NCPDP format you expect to receive or send.

For more information about Data Definition Format files, see the Sterling
Gentran:Server Application Integration User Guide.

About this task

Use this procedure to analyze NCPDP data.

Procedure
1. Obtain sample data that is in the NCPDP format you will send to or receive

from the processor, intermediary, or provider (trading partner).
2. Analyze the sample data to determine the segment and element layouts and

field lengths.
3. Find out which data elements the trading partner requires.
4. Determine the trading partner’s ability to accept variable-length transactions

and truncated data elements.
5. Determine the kind of data contained in each segment and element.
6. List the map components and layout information for your NCPDP Data

Definition Format file.
7. When you build the NCPDP side of your map, add or delete optional fields

and segments as necessary to accommodate your trading partner’s
requirements and those of your organization.
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NCPDP Map Components
This diagram illustrates an example map that translates inbound data that is in
NCPDP format into an application format.

This table describes the icons that Sterling Gentran:Server uses to visually
represent the NCPDP map components:

Icon Description

The NCPDP File Format icon (a pill bottle) identifies the NCPDP file. The
file object is the primary component. All other map components are
subordinate to the file object.

A group icon indicates a looping structure that contains related segments
and groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is exhausted.

A segment icon (a pill) identifies a segment. The left side of the icon is red
and the right side contains a "P" if the segment is positional. The left side of
the icon is blue and the right side contains a "D" if the segment is delimited.

A field icon represents the smallest piece of information defined in an
NCPDP standard. Fields usually do not have useful meaning until they are
combined into segments. Fields can be positional (blue icon) or delimited
(green icon). A red indicates an NCPDP data record.

A linked field icon represents a field that is linked to an element or field on
the opposite side of the map, or which has a standard rule attached to it.

A count field icon represents a count field, which occurs once and contains
a count of the loop that follows.

A counter field icon represents a counter field, which occurs at the
beginning of each occurrence of a looping set of fields.

Creating an Inbound NCPDP Map
After you analyze the NCPDP data you expect to receive from your trading
partner, you are ready to create a map that will translate the NCPDP data into
another format, such as your application format.

Chapter 3. Creating NCPDP Maps 13



About this task

For more detailed instructions about creating maps, see the Creating a Map section
in the Sterling Gentran:Server Application Integration User Guide.

The input side of your map must be generated by importing a data definition file
(DDF) that describes the layout of the incoming file. We recommend that you use
the appropriate DDF that IBM provided on your Standards DVD. The IBM DDFs
contain the batch header and batch trailer segments as well as the transaction
segments.

Use this procedure to create an NCPDP map.

Procedure
1. Start the Application Integration subsystem.
2. Select File > New to start the New Map Wizard.
3. Enter the following information and click Next.

a. Select the appropriate map type (such as import, export).
b. Type the unique name of the map, omitting the .MAP extension.
c. Type your name if it differs from the user name that the system supplied.

4. Do one of the following:
v To use an NCPDP DDF file that IBM provided, click Load the data format

from a saved definition and then navigate to the DDF in the directory that
you use to store your NCPDP file definitions.

v To create an NCPDP map without using a DDF, click Create a new data
format using the syntax and select NCPDP.

5. When prompted for the output format, select the appropriate options.
6. Click Finish to begin editing your map.
7. If you are creating a new data format, define the NCPDP map file, name it,

and save it. See the section on Structuring an NCPDP Map for instructions.
8. If required, define the output format. You can name it and save it to use in

another map.
9. Complete the map by setting standard or extended rules and linking

components on the input and output sides.
10. Save the map.
11. Compile the map to create a translation object.

Creating an Outbound NCPDP Map
After you analyze the NCPDP format you send to your trading partner, you are
ready to create a map that will translate your application (or other formatted) data
into an NCPDP standard format.

About this task

For more detailed instructions about creating maps, see the Creating a Map topic
in the Sterling Gentran:Server Application Integration User Guide.

The output side of your map must be a data definition file (DDF) that describes
the layout of the output file. We recommend that you use the appropriate DDF
that IBM provided on your Standards DVD. The IBM DDFs contain the batch
header and batch trailer segments as well as the transaction segments.
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Use this procedure to create an outbound NCPDP map.

Procedure
1. Start the Application Integration subsystem.
2. Select File > New to start the New Map Wizard.
3. Enter the following information and click Next.

a. Select the appropriate map type (such as import, export).
b. Type the unique name of the map, omitting the .MAP extension.
c. Type your name if it differs from the user name that the system supplied.

4. Do one of the following:
v To use an NCPDP DDF file that IBM provided, click Load the data format

from a saved definition and then navigate to the DDF in the directory that
you use to store your NCPDP file definitions.

v To create an NCPDP map without using a DDF, click Create a new data
format using the syntax and select NCPDP.

5. Click Finish to begin editing your map.
6. If required, define or edit the input format. You can name it and save it to use

in another map. Then continue with Step 13.
7. If you are creating a new data format, define the NCPDP map file by inserting

components and setting the properties. You can name it and save it to use in
another map. See the section on Structuring an NCPDP Map for instructions.

8. Complete the map by adding standard and extended rules and linking
components on the input and output sides.

9. Save the map.
10. Compile the map to create a translation object.
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Chapter 4. Structuring an NCPDP Map

Requirements for Outbound NCPDP Maps
When creating an Outbound NCPDP map, you must use a standard or extended
rule to update the Document database table (Document_tb) in your Sterling
Gentran:Server database with the following information: update Appfield6 to Batch
Header Number and ControlNumber to Transaction Reference Number.

The build process utilizes these values when creating the Batch Header, Batch
Detail and Batch Trailer Segments for each batch, and if these values are not
updated in the Document table, the build process pulls the values from the
Outbound Envelope Information for that partner relationship.

The Unattended process also utilizes the value in Appfield6 of the Document Table
to determine which transactions should be placed in the same batch. If there is no
value in Appfield6 the unattended process places all transactions that are ready to
send in the same batch.

See theSterling Gentran:Server Application Integration User Guide for more
information on standard and extended rules.

NCPDP Map Structure
In Sterling Gentran:Server, an NCPDP map consists of an NCPDP File object, batch
segment objects, positional segment objects, delimited segment objects, and field
objects. The segments in the transaction portion of a transmission must be
contained in a group.

These are the basic segments in a batch transmission. You can have up to four
transaction segments.
v Batch Header Segment
v Batch Detail Segment
v Transaction Header Segment
v Patient Segment
v Insurance Segment
v Transaction Segment
v Transaction Segment
v Transaction Segment
v Transaction Segment
v Batch Trailer Segment

There are two types of segments: positional and delimited.

These are positional (fixed-length) segments:
v Batch Header Segment
v Batch Detail Segment
v Transaction Header Segment
v Batch Trailer Segment
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All other segments in an NCPDP transmission are delimited (variable-length)
segments.

These are the types of fields that Sterling Gentran:Server supports for NCPDP
transmissions:
v Number
v String
v Date/Time

Field Format Values
This table shows the NCPDP field format values that Sterling Gentran:Server
supports:

Data Type Data Format

Number v XNumeric (0 - 9) - An unsigned numeric. Always right-justified and
zero-filled. Corresponds to “N” format in the NCPDP Standard.

v Overpunch (0 - 9) - A signed numeric with implied decimal position. The
sign is internal and trailing; zero is always positive; field is always
right-justified; and field contains a zero-filled dollar-cents amount with
two positions to the right of the implied decimal point. All other positions
are to the left of the implied decimal point. A dollar field with an
Overpunch sign replaces the right-most digit in the field. Corresponds to
“D” format in the NCPDP Standard.

Note: Overpunch signs are used in dollar fields to represent positive and
negative dollar amounts without expanding the size of the field to hold a
plus or minus character. The right-most (least significant) digit of a dollar
field must be an Overpunch sign, not a digit. The signed value designates
the positive or negative status of the numeric value.

For example: The dollar field of $99.95 is represented as 999E with
truncation. A negative dollar amount of $2.50 is represented as 25} with
truncation.

String Free format (which indicates that any characters are acceptable in the field
because the translator does not check the characters for compliance) or A/N
(alpha numeric) format in the NCPDP Standard. Syntax token that defines a
range of characters that are valid for a given field. These tokens are
predefined:

v X = A - Z, a - z, 0 - 9 plus a set of characters

v A = A - Z, a - z

v J = A- - Z, a - z, 0 - 9 plus a set of characters

v N = 0 - 9

Note: To view a list of the defined syntax tokens, select Syntax Tokens from
the Application Integration Edit menu. The system displays the Syntax
Tokens dialog box, which displays the characters defined for each syntax
token.

Date/Time Date or time format.

For example:

v YYYYMMDD (used in NCPDP Standard)

v YYMMDD

v HHMMSS

v HHMM

18 IBM Sterling Gentran:Server for Windows: HIPAA and NCPDP Compliance Guide



NCPDP File Properties Dialog Box

NCPDP File Properties - Name Tab
The NCPDP File Properties dialog box is used to define information that helps the
translator identify different data structures in the Input or Output file. The
information defined on this dialog box applies to the whole side of the map.

The Name tab is used to define the name of the root map object. This diagram
illustrates the Name tab.

This table describes the parts of the Name tab.

Part Function

Please enter the
name

Defines the name of the root map object.

Please enter a short
description

Describes the root map object.

NCPDP File Properties - Segment Tab
The Segment tab is used to specify segment separators and other structural
information.

When NCPDP is on the Input side of a map, the translator uses this information to
identify and validate data structures. When NCPDP is on the Output side of a
map, the system uses the segment information to generate correct NCPDP data
structures.

This diagram illustrates the Segment tab.
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This table describes the parts of the Segment tab.

Part Function

Positional Segments

Use Separators Indicates that a separator character marks the beginning of a
positional segment.
Note: If you define two separators, the translator will put them in
front of all positional segments.

Positional and Delimited Segments

Stream Segments Turns streaming on and off.

When this box is selected, each Output segment follows another,
without a carriage return or line feed to separate them.
Note: The default for NCPDP is streamed. If you deselect this
checkbox, the translator will put a CR/LF at the beginning of each
segment.

Uppercase Strings For outbound data, this checkbox causes the system to convert all
strings to uppercase characters. For inbound data, the system
ignores this checkbox.
Note: NCPDP requires all alphabetic characters to be uppercase.

Delimited Segments

Specify Separators Enables you to change the default separator characters used to
delimit the data structures.
Important: The NCPDP standard has required separator characters.
When the User Separator checkbox is selected, Sterling
Gentran:Server displays these separators in the appropriate boxes.
We strongly recommend that you do NOT change these values.
Only change these values if you are using a type of format other
than NCPDP.

Segment Separator Specifies the character used to separate segments. The default
character is Ox1E.

Group Separator Specifies the character used to separate groups. The default
character is Ox1D.

Field Separator Specifies the character used to separate fields. The default character
is Ox1C.

Batch Segments
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Part Function

Start of Text (STX) Specifies the value that marks the start of the batch record within
the file.
Note: Defines the delimiter used to delineate the beginning of a
batch segment.

End of Text (ETX) Specifies the value that marks the end of the batch record within the
file.
Note: Defines the delimiter used to delineate the end of a batch
segment.

Other fields

Field ID Length Specifies the length of the field identifier. Default value is 2 for
delimited segments.
Note: The field ID allows the translator to identify each field, no
matter what order it is located in.

Truncate data Turns data truncation on and off.�On the Output side of a map, if
this checkbox is selected, the system removes leading zeros, fillers,
padding, and spaces from data elements that are not mandatory. On
the Input side of the map, it also removes trailing spaces.

NCPDP File Properties - Loop Extended Rules tab
The Loop Extended Rules tab is used to create extended rules at the file object
level.

This table describes the parts of the Loop Extended Rules tab.

Part Function

On Begin Specifies that the extended rule is executed before the system processes
the Input or Output side of the map.

On End Specifies that the extended rule is executed after the system processes
the Input or Output side of the map.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. Displays any warnings or errors in the
Errors list.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked Compile to compile
the extended rule.

NCPDP Group Properties Dialog Box

NCPDP Group Properties - Name Tab
The NCPDP Group Properties dialog box is used to define information about a
group structure in the file.

The Name tab is used to define the name of the group map object. This diagram
illustrates the Name tab.
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This table describes the parts of the Name tab.

Part Function

Please enter the
name

Defines the name of the group map object.

Please enter a short
description

Describes the group map object.

NCPDP Group Properties - Separator Tab
The Separator tab is used to indicate whether or not the NCPDP Group Separator
is used in the file.

This diagram illustrates the Separator tab.

This table describes the parts of the Separator tab.
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Part Function

Use NCPDP Group
Separator

Toggles the activation of the NCPDP Group Separator.

If the group is on the Input side of a map, this checkbox causes the
system to expect a group separator in the Input file at the beginning
of each group.

If the group is on the Output side of a map, this checkbox causes the
system to insert a group separator in the Output file at the beginning
of each occurrence of the group.

NCPDP Group Properties - Looping Tab
The Looping tab is used to specify that the group is part of a repeating (looping)
structure.

This diagram illustrates the Looping tab.

This table lists the parts of the Looping tab and their functions.

Part Function

Minimum Usage Specifies the minimum number of times the loop must be repeated.

Maximum Usage Specifies the maximum number of times the loop can be repeated.

Promote records to
parent

Indicates (if selected) that the subordinate records and groups should
be extracted and located in the parent group when the group is
compiled.

NCPDP Group Properties - Loop Extended Rules tab
The Loop Extended Rules tab is used to set extended rules for the group.

This diagram illustrates the Loop Extended Rules tab of the NCPDP Group
Properties dialog box.
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This table describes the parts of the Loop Extended Rules tab.

Part Function

On Begin Specifies that the extended rule is executed before the system processes
each occurrence of the group.

On End Specifies that the extended rule is executed after the system processes
each occurrence of the group.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. Displays any warnings or errors in the
Errors list.

Extended rule Defines the extended rule.

Errors Displays any errors generated when you clicked Compile to compile the
extended rule.

NCPDP Positional Segment Properties Dialog Box

NCPDP Positional Segment Properties - Name Tab
The NCPDP Positional Segment Properties dialog box is used to define information
about a positional segment.

The Name tab is used to define the name of the map object. This diagram
illustrates the Name tab.
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This table describes the parts of the Name tab.

Part Function

Please enter the name Defines the name of the positional segment.

Please enter a short
description

Describes the positional segment.

NCPDP Positional Segment Properties - Tag Tab
The Tag tab is used to define the segment identifier or transaction code associated
with the positional segment. The translator uses the tag to correctly associate a
segment in the Input file with its corresponding map segment.

Note: You must define a tag for inbound-side positional segments. This option is
not used for Output-side positional segments.

This diagram illustrates the Tag tab.
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This table describes the parts of the Tag tab.

Part Function

Transaction Code Used to specify a value that Sterling Gentran:Server can use to
identify the segment in the Input file.

v For header segments, this box is used to specify the NCPDP
Transaction Code associated with the positional segment.

v For batch segments, this box is used to specify the segment
identifier.

Position For the Input side of a map, specifies the character position in the
data (starting from 1) where the Transaction Code or segment
identifier is located. This is used to identify the segment.
Note: This option is not used for segments on the Output side of a
map.

This is a batch
segment

Indicates that the segment is a Batch Header Segment, Batch Detail
Data Segment, or Batch Trailer Segment.

When you select this checkbox for a batch segment on the Output
side of a map, this option causes the translator to insert a start-of-text
(STX) character at the beginning of the segment and an end-of-text
(ETX) character at the end of the segment.

NCPDP Positional Segment Properties - Key Field Tab
The Key Field tab is used to specify a second qualification in selecting a segment.
(The segment name is the first qualification).

This diagram illustrates the Key Field tab.

This table describes the parts of the Key Field tab.

Part Function

Field Specifies the key field for this segment. The translator uses this
value in addition to the tag as criteria to use when it is matching
a data segment from an Input file to a map segment.

Matching rules (Input side of map only)
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Part Function

Use constant Indicates that a constant is used as a matching rule. The list is
used to select the constant. The Edit button is used to display the
Map Constants dialog box.

Use codelist Indicates that a codelist is used as a matching rule. The list is
used to select the codelist. The Edit button is used to display the
Code Lists dialog box.

Match record when key
does not match

Instructs the system to ignore the specified key field when
matching a data segment from the Input file to a map segment.

NCPDP Positional Segment Properties - Looping tab
The Looping tab is used to specify that the segment is part of a repeating (looping)
structure.

This diagram illustrates the Looping tab.

This table describes the parts of the Looping tab.

Part Function

Minimum Usage Specifies the minimum number of times the segment must be
repeated.

Maximum Usage Specifies the maximum number of times the segment can be repeated.

Normal Not applicable to NCPDP.

Loop Start Not applicable to NCPDP.

Loop End Not applicable to NCPDP.

NCPDP Positional Field Properties Dialog Box

NCPDP Positional Field Properties - Name tab
The NCPDP Positional Field Properties dialog box is used to define information
about a positional field.
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The Name tab is used to define the name of the positional field. This diagram
illustrates the Name tab.

This table describes the parts of the Name tab.

Part Function

Please enter the
name

Defines the name of the map object.

Please enter a short
description

Describes the map object.

NCPDP Positional Field Properties - Validation tab
The Validation tab is used to set the field’s data type, data format, and minimum
and maximum length.

This diagram illustrates the Validation tab.

This table describes the parts of the Validation tab.
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Part Function

Check here if this
field is mandatory

Indicates that this field is required.

Minimum (field
length)

Specifies the minimum length of this field.

Maximum (field
length)

Specifies the maximum length of this field.

Please choose the
data-type of this field

Specifies the field’s data type:

v String

v Number

v Date/Time

Please choose the
format of the data in
this field

Specifies the data format. The available formats are based on the
data type.

String: X

Number:

v Overpunch
Note: The Overpunch format specifies that the last digit
represents the sign (value) of the number).

v Xnumeric

v The Xnumeric format specifies that a space is reserved to the
right of the number for a space (if the number is positive) or a
minus sign (if the number is negative).

v N0 - N9

Date: YYYYMMDD

Data is read/written
as raw bytes

Not used for NCPDP.

use little-endian byte
ordering

Not used for NCPDP.

use big-endian byte
ordering

Not used for NCPDP.

Width Not used for NCPDP.

NCPDP Positional Field Properties - Position tab
The Position tab is used to set information about the position of the field in the
positional segment.

This diagram illustrates the Position tab.
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This table describes the parts of the Position tab.

Part Function

Enter the position where
this field begins in the
record (starting from 1)

Specifies the starting position of this field.

Enter the number of
characters this field
occupies in the record

Specifies the length of this field.

Enter the character used in
empty portions of the field

Specifies the type of character used to occupy blank portions
of the field.

To use this field, type the character you want to use as the
padding character. For example, type 0 (zero) to pad the field
with zeros.

Press the space bar to use a space in empty portions of the
field. The system displays SP in the box.

How is the field’s data
aligned in the record?

Indicates how the data is aligned:

v beginning of the field = left-aligned

v middle of the field = centered

v end of the field - right-aligned

NCPDP Positional Field Properties - Extended Rule tab
The Extended Rule tab is used to specify an extended rule for this map object.

This diagram illustrates the Extended Rule tab.
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This table describes the parts of the Extended Rule tab.

Part Function

Please enter the
extended rule below

Enables you to enter the extended rule you want to use for this
field.

Errors Displays any errors that result when you compile this extended
rule.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. Displays any warnings or errors in
the Errors list.

NCPDP Positional Field Properties - Standard Rule tab
The Standard Rule tab is used to specify a standard rule for this map object.

This table describes the parts of the Standard Rule tab.

Part Function

Please select the
standard rule to use

Specifies the standard rule to use for this field.

NCPDP Positional Field Properties - Conditions tab
The Conditions tab is used to set relational conditions to connect fields together for
syntax or compliance reasons.

This diagram illustrates the Conditions tab.
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This table describes the parts of the Conditions tab.

Part Function

Please choose the
type of relationship
to use

Specifies the type of relationship between this field and another field.

v Paired/Multiple - If any of the specified fields are present, then all
fields must be present.

v Required. - At least one of the specified fields must be present.

v Exclusion - No more than one of the specified fields may be
present.

v Conditional - If the first Condition field is present, the rest of the
fields must also be present.

v List Conditional - If the first Condition field is present, at least one
of the specified fields must also be present.

Please select the
condition field

Used to select the first field from the Condition field list. This is the
field on which the conditional relationship is based.

This field is active only when the type of relationship is Conditional
or List Conditional.

Available fields Lists the fields in the map that can be used in the relationship.

Fields used in
relationship

Specifies the fields used in the relationship. You build this list by
selecting fields in the Possible Fields list and then clicking the Add
button.

NCPDP Delimited Segment Properties Dialog Box

NCPDP Delimited Segment Properties - Name tab
The NCPDP Delimited Segment Properties dialog box is used to define information
about a delimited segment.

The Name tab is used to define the name of the delimited segment map object.
This diagram illustrates the Name tab.
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This table describes the parts of the Name tab.

Part Function

Please enter the
name

Defines the name of the map object.

Please enter a short
description

Describes the map object.

NCPDP Delimited Segment Properties - Tag tab
The Tag tab is used to define the segment identifier and segment ID value
associated with the delimited segment in the map.

This diagram illustrates the Tag tab.

This table describes the parts of the Tag tab.
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Part Function

Field ID Specifies the Field ID of the field that contains the segment identifier,
which is either what you expect or what you want generated. See the
NCPDP standards for values.
Note: Every delimited field has a field ID.

Segment ID Specifies the Segment ID of the segment. See the NCPDP standards
for values.

NCPDP Delimited Segment Properties - Key Field tab
The Key Field tab is used to specify a second qualification in matching a segment
in the Input file with the segment in the map. (The segment name is the first
qualification.)

This diagram illustrates the Key Field tab.

This table describes the parts of the Key Field tab.

Part Function

Field Selects the field to be used as the key field in this segment.

Use constant Indicates (if selected) that a constant is used as a matching rule. The
list is used to select the constant. The Edit button displays the Map
Constants dialog box.

Use codelist Indicates (if selected) that a codelist is used as a matching rule. The
list is used to select the codelist. The Edit button displays the Code
Lists dialog box.

Match record when
key does not match

Instructs the system to ignore the specified key field when matching
a data segment from the Input file to a map segment.

NCPDP Delimited Segment Properties - Looping tab
The Looping tab is used to specify that the segment is part of a repeating (looping)
structure.

This diagram illustrates the Looping tab.
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This table describes the parts of the Looping tab.

Part Function

Min Usage Specifies the minimum number of times the segment must be repeated.

Max Usage Specifies the maximum number of times the segment can be repeated.

Normal Not applicable to NCPDP.

Loop Start Not applicable to NCPDP.

Loop End Not applicable to NCPDP.

NCPDP Delimited Field Properties Dialog Box

NCPDP Delimited Field Properties - Name tab
The NCPDP Delimited Field Properties dialog box is used to define information
about a delimited field.

The Name tab is used to define the name of the delimited field map object. This
diagram illustrates the Name tab.
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This table describes the parts of the Name tab.

Part Function

Please enter the name Defines the name of the map object.

Please enter a short
description

Describes the map object.

NCPDP Delimited Field Properties - Tag tab
The Tag tab is used to define the field identifier associated with the delimited field.

This diagram illustrates the Tag tab.

This table describes the parts of the Tag tab.

Part Function

Field ID Specifies the field identifier for this individual field.

Fixed Order Indicates (if selected) that this field must occur in the order specified
within the segment.
Note: If this checkbox is selected, the translator will generate an error
if the field appears, for example, in the first position in the map but
the third position in the data.

NCPDP Delimited Field Properties - Validation tab
The Validation tab is used to set the field’s data type, format, and minimum and
maximum lengths.

This diagram illustrates the Validation tab.
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This table describes the parts of the Validation tab.

Part Function

Check here if this
field is mandatory

Indicates that this field is required.

Minimum (field
length)

Specifies the minimum length of this field.

Maximum (field
length)

Specifies the maximum length of this field.

Please choose the
data-type of this field

Specifies the field’s data type:

v String

v Number

v Date/Time

Please choose the
format of the data in
this field

Specifies the data format.

Data is read/written
as raw bytes

Not applicable to NCPDP.

use little-endian byte
ordering

Not applicable to NCPDP.

use big-endian byte
ordering

Not applicable to NCPDP.

Width Not applicable to NCPDP.

NCPDP Delimited Field Properties - Extended Rule tab
The Extended Rule tab is used to specify an extended rule for this field.

This diagram illustrates the Extended Rule tab.
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This table describes the parts of the Extended Rule tab.

Part Function

Please enter the
extended rule below

Enables you to enter the extended rule you want to use for this
field.

Errors Displays any errors that result when you compile this extended
rule.

Full Screen Maximizes the dialog box.

Compile Compiles the extended rule. Displays any warnings or errors in the
Errors list.

NCPDP Delimited Field Properties - Standard Rule tab
The Standard Rule tab is used to specify a standard rule for this map object.

This diagram illustrates the Standard Rule tab.

This table describes the parts of the Standard Rule tab.
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Part Function

Please select the
standard rule to use

Specifies the standard rule to use for this field.

NCPDP Delimited Field Properties - Conditions tab
The Conditions tab is used to select relational conditions to connect parts for
syntax or compliance reasons.

This diagram illustrates the Conditions tab.

This table describes the parts of the Conditions tab.

Part Function

Please choose the
type of relationship
to use

Selects the type of relationship between this field and another field.

Please select the
condition field

Specifies the other field in the relationship.

Available fields Lists the fields that can be used in the relationship.

Fields used in
relationship

Specifies the fields used in the relationship.

NCPDP Count Field Properties Dialog Box

NCPDP Count Field Properties - Name tab
The Count Properties dialog box is used to set the properties of a count field.

Note: A count field can contain fields that loop.

The Name tab is used to define the name of the count field. It is also used to
describe the field. This diagram illustrates the Name tab.
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This table describes the parts of the Name tab.

Part Function

Please enter the
name

Defines the name of the count field.

Please enter a short
description

Describes the count field.

NCPDP Count Field Properties - Tag tab
The Tag tab is used to define the field identifier associated with the count field.

This diagram illustrates the Tag tab.

This table describes the parts of the Tag tab.

Part Function

Field ID Specifies the field identifier for this field.
Note: Every count field must have a Field ID.
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Part Function

Fixed Order Indicates (if selected) that this field must occur in the order specified
within the segment.
Note: This is mandatory for NCPDP.

NCPDP Count Field Properties - Repeat tab
The Repeat tab is used to set the minimum and maximum times that this count
field can repeat (loop).

This diagram illustrates the Repeat tab.

This table describes the parts of the Repeat tab.

Part Function

Minimum Usage Specifies the minimum number of times this field repeats.

Maximum Usage Specifies the maximum number of times this field repeats.

Treat this field as a
repeating field

Indicates that this field is a repeating (looping) field.

NCPDP Counter Field Properties Dialog Box

NCPDP Counter Field Properties - Name tab
The Counter Field Properties dialog box is used to set the properties of a counter
field.

The Name tab is used to define the name of the counter field. It is also used to
describe the field. This diagram illustrates the Name tab.
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This table describes the parts of the Name tab.

Part Function

Please enter the
name

Defines the name of the counter field.

Please enter a short
description

Describes the map object.

NCPDP Counter Field Properties - Tag tab
The Tag tab is used to define the field identifier associated with the counter field.

This diagram illustrates the Tag tab.

This table describes the parts of the Tag tab.

Part Function

Field ID Specifies the field identifier for this field.
Note: Every counter field must have a Field ID.
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Part Function

Fixed Order Indicates (if selected) that this field must occur in the order specified
within the segment.
Note: This is mandatory for NCPDP.

NCPDP Counter Field Properties - Repeat tab
The Repeat tab is used to set the minimum and maximum times that this counter
field can repeat (loop).

This diagram illustrates the Repeat tab.

This table describes the parts of the Repeat tab.

Part Function

Minimum Usage Specifies the minimum number of times this field repeats.

Maximum Usage Specifies the maximum number of times this field repeats.

Treat this field as a
repeating field

Indicates that is field is a repeating (looping) field.

How to Define an NCPDP Batch File
There are two methods of creating the map components for an NCPDP batch file:
v Loading an NCPDP DDF
v NCPDP Map Component Creation Process

Loading an NCPDP DDF
The simplest way to create the NCPDP side of your map is to load the appropriate
NCPDP DDF that IBM supplied with your Sterling Gentran:Server product. Each
DDF contains the required batch components as well as the transaction
components. After you load the DDF, you can add, cut, and modify components to
meet your needs.
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About this task

See Copying the NCPDP DDFs for more information.

Use this procedure to copy components from a translation object.

Procedure
1. Start the NCPDP map in the Application Integration mapper.
2. When prompted for the format, select Load the data format from a saved

definition and navigate to the appropriate NCPDP DDF.
See the section on Creating NCPDP Maps for instructions.

3. Complete the NCPDP map by modifying components as necessary and linking
input fields to output fields.

Note: To modify a map component, right-click the map component you want
to modify and select Properties.
See the Map Design section of the Sterling Gentran:Server Application Integration
User Guide for detailed instructions on modifying map components.

4. Save your changes.
5. Compile the map to create a translation object.

NCPDP Map Component Creation Process
This topic describes the process of defining the NCPDP components in a map.

This table describes the process for manually creating NCPDP map components.

Stage Description

1 Set the NCPDP File Properties. See Configuring NCPDP File Properties for
instructions.

2 Create the batch header. See Creating the Batch Header Segment for
instructions.

3 Create the groups. See Creating a Group for instructions.

4 Create the batch detail segment. See Creating the Batch Detail Data Segment
for instructions.

5 Create the transmission header segment. See Creating a Transaction Header
Segment for instructions.

6 Create the transmission segments. See Creating the Batch Trailer Segment
for instructions.

7 Create the transaction groups. See Creating a Group for instructions.

8 Create the transaction segments (for example, Patient segment, Insurance
segment) within the groups. See Creating a Positional Segment and Creating
a Delimited Segment for instructions.

9 Create the fields. See How to Create a Positional Field, Creating a Delimited
Field, and Creating a Count Field, and Creating a Counter Field for
instructions.

10 Create the batch trailer. See Creating the Batch Trailer Segment for
instructions.
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Configuring NCPDP File Properties
When the NCPDP file object is on the input side of the map, the translator uses the
properties to parse and validate input data. When the NCPDP file object is on the
output side, the translator uses the properties to structure the output.

About this task

Use this procedure to set the NCPDP File Properties.

Procedure
1. Right-click the NCPDP file icon and select Properties.

The system displays the NCPDP File Properties Dialog Box.
2. On the Name tab, type the name and description of the root NCPDP map

object.
3. Select the Segment tab to choose settings that enable the translator to either

identify and validate data structures in the NCPDP input file or structure the
NCPDP output file.

4. In the Positional Segments section, do one of the following:
v To delimit positional segments, leave the Use Separators checkbox blank.

This is the default setting for NCPDP.
v To delimit positional segments (use separators to mark the beginning of the

segment), select Use Separators and type the separator characters in boxes 1
and 2.

For example: If you want to delimit positional segments with a carriage return
and line feed, specify the carriage return character in box 1 (0x0D) and the
line feed character in box 2 (0x0A).

5. If the file object is on the input side of the map, do you expect each input
segment to follow another, without a carriage return or line feed to separate
them? If the file object is on the output side of the map, do you want output
segments structured this way?
v If yes, select Stream Segments. (We recommend this option.)
v If no, continue with the next step.

If you do not select this checkbox, Sterling Gentran:Server assumes that
each segment starts with a carriage return or line feed.

6. To have the translator change mixed-case characters to all uppercase
characters (valid on the output side of the map only), select Uppercase
Strings.

7. In the Delimited Segments section, select Specify Separators.
The system displays the default separator characters for NCPDP data in the
appropriate boxes.

8. In the Batch Segments section, accept the default values in the Start of Text
and End of Text boxes. These values mark the beginning and ending of the
batch segment within the file.

9. Accept the Field ID Length setting (2) as the length of the field identifiers.
10. To truncate the output data (removing leading zeros, fillers, padding, and

leading spaces), select Truncate Data.

Note: Make sure that your trading partner accepts truncated data.
11. To set extended rules at the File level, do the following. Otherwise, continue

with step 12.
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a. On the Loop Extended Rules tab, select either On Begin or On End to
indicate when you want the extended rule executed (before the system
processes the file or after processing).

b. Type the extended rule.
c. Click Compile to compile the extended rule.
d. Resolve any errors displayed in the Errors portion of the dialog box.

12. Click OK to save your changes.

Creating the Batch Header Segment
The batch header segment is a positional segment that contains the Sender ID and
Receiver ID. Each file can have only one batch header segment.

About this task

Note: For inbound transmissions, you must map the Batch Number field in the
batch header. This is necessary because you must use the same value in the Batch
Response Header segment.

Use this procedure to create the batch header segment in the NCPDP side of a
map.

Procedure
1. Right-click the NCPDP file icon and select Create Sub > Positional Segment.

The system displays the NCPDP Positional Segment Properties Dialog Box.
2. On the Name tab, type the segment name.
3. Type a description of the segment and click OK to save your changes.
4. On the Tag tab, do the following:

v Type 00 in the Transaction Code box. This is the segment identification code
for a batch header.

v Type 0 (the default value) in the Position box. This is the position of the
segment identifier within the segment.

v Select This is a batch segment.

Important: You must define the tag for an Input segment.
5. Click OK to save your changes.

Creating a Group
In an NCPDP map, a transaction is represented by a map group. A group contains
related segments, groups, or both that repeat in sequence until either the data ends
or the maximum number of times that the loop is allowed to repeat is exhausted.
The system permits up to four repetitions.

About this task

In NCPDP transmissions, a group separator character indicates the start of a
transaction (except for Eligibility Verification transactions). You can choose to have
Sterling Gentran:Server insert the NCPDP group separator character when you
create or modify a map group.

See Separator Characters for more information.

Use this procedure to create a group in a map.
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Procedure
1. Select the map component that precedes the group you are creating in the file

layout.
2. Depending on the level, select Edit > Create Sub > Group or Edit > Insert >

Group.
The system displays the NCPDP Group Properties Dialog Box.

3. On the Name tab, type the name of the group, such as the transaction name.

Note: Do not use spaces or dashes (-) in the group name. You can use the
underscore (_) to separate words.

4. Type a description of this group and click OK.
5. To automatically insert the NCPDP group separator before the data in this

group, click the Separator tab and select Use NCPDP Group Separator. Then
click OK.

6. Select the Looping tab.
7. Type the minimum number of times the loop must be repeated.

Note: For a conditional loop, the minimum usage should always be 0. For a
mandatory loop, the minimum usage should be 1 or greater.

8. Type the maximum number of times the loop can be repeated.
9. For a single iteration group: To specify that the subordinate records and

groups should be extracted and located in the parent group when the group is
compiled, select Promote records to parent and click OK. If you do not want
to specify that the subordinate records and groups should be extracted, click
OK.

10. For a multi-iteration group: To specify an extended rule for this group, click
the Loop Extended Rules tab and enter the extended rule. Click OK to save
your changes.
The system displays the Loop Extended Rules tab.

11. Click OK to create the group.

Creating the Batch Detail Data Segment
The batch detail data segment is a positional segment that contains the Transaction
Reference Number. In a Sterling Gentran:Server NCPDP map, this segment
contains only two fields - Segment Identifier and Transaction Reference Number.

About this task

In your map, the NCPDP Data Record described in the NCPDP Standard for a
Detail Data Record follows the Batch Detail Data Segment. The Data Record begins
with a Transaction Header Segment.

For inbound transmissions, you must map the Transaction Reference Number field.
This is because you have to use the same number when you send the outbound
response.

See Creating a Transaction Header Segment for instructions.

Use this procedure to create a batch detail data segment in the NCPDP side of a
map.
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Procedure
1. Right-click the icon for the batch header segment and select Insert/Positional

Segment.
The system displays the NCPDP Positional Segment Properties Dialog Box.

2. On the Name tab, type the segment name.
3. Type a description of the segmentand click OK to save your changes.
4. On the Tag tab, do the following:

v Type G1 in the Transaction Code box. This is the segment identification code
for a batch detail segment.

v Type 0 (the position of the segment identifier within the segment) in the
Position box.

v Select This is a batch segment.
5. Click OK to save your changes.

Creating a Transaction Header Segment
A Transaction Header segment is a positional segment that indicates if the
transaction is a request or response. This header segment contains one field that
Sterling Gentran:Server uses to determine the Trading Partnership code for
inbound translation.

About this task

Each Batch Detail Data record has only one transaction header. In your map, the
Transaction Header segment immediately follows the Batch Detail Data segment.

Use this procedure to create a Transaction Header segment in the NCPDP side of a
map.

Procedure
1. Right-click the icon for the batch detail data segment and select

Insert/Positional Segment.
The system displays the NCPDP Positional Segment Properties Dialog Box.

2. On the Name tab, type the segment name.
3. Type a description of the segment and click OK to save your changes.
4. On the Tag tab, do the following:

v Type the NCPDP transaction code (such as E1, B1, B2) in the Transaction
Code box.

v Type the starting position of the Transaction Code in the Position box.
5. Click OK to save your changes.

Creating the Batch Trailer Segment
The Batch Trailer segment is a positional segment that contains the total number of
segments in the batch, including the Batch Header and Batch Trailer segments. This
segment also contains a message field that can be used to include information
about the batch transmission. Each file can have only one Batch Trailer segment.

About this task

Use this procedure to create the batch header segment in the NCPDP side of a
map.
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Procedure
1. Right-click the last icon on the NCPDP side of the map and select

Insert/Positional Segment.
The system displays the NCPDP Positional Segment Properties Dialog Box.

2. On the Name tab, type the segment name.
3. Type a description of the segment and click OK to save your changes.
4. Click the Tag tab.
5. Select This is a batch segment.
6. Type 99 in the Transaction Code box. This is the segment identification code for

a batch trailer.
7. Type the starting position of the Segment Identifier in the Position box.
8. Click OK to save your changes.

Creating a Positional Segment
The fields in positional segments are always in fixed positions and do not require
separators. The NCPDP Positional Segment Properties tab enables you to specify
an identifying value for a positional segment, the loop usage and type, and
constants.

About this task

Use this procedure to create a positional segment in the NCPDP side of a map.

Procedure
1. Select the map component which precedes the segment you are creating.
2. Select Edit > Create Sub > Positional Segment or Edit > Insert > Positional

Segment, depending on the level of the selected map component.
The system displays the NCPDP Positional Segment Properties Dialog Box.

3. On the Name tab, type the segment name.

Note: If a segment occurs more than once in a map it is identified by its name
<ID>. The second and subsequent occurrences are identified by <ID>:n, where
n is the number of the occurrence in the map.

4. Type a description for the segment.
5. To specify an identification tag for this segment, select the Tag tab and enter

the segment identification code.

Note: You must define the tag for an input segment.
6. To use a key field, select the Key Field tab and complete the appropriate

fields.
7. If the segment is a looping structure, select the Looping tab. Otherwise, accept

the defaults and click OK.
8. Type the minimum amount of times the segment must repeat.

Note: If the Min Usage box contains a 0, the segment is conditional. If the
Min Usage box contains a 1 or greater, the segment is mandatory.

9. If you want the segment to repeat (loop), type the maximum amount of times
it can repeat.

10. Click OK to save changes to the segment.
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Creating a Delimited Segment
The Patient, Insurance, Claim, Pharmacy Provider, and other transaction-level
segments are delimited segments. Delimited segments and their fields require
separators because their lengths are variable. The NCPDP Delimited Segment
Properties dialog box enables you to create a delimited segment.

About this task

Use this procedure to create a delimited segment in the NCPDP side of a map.

Procedure
1. Depending on the level of the selected map component, right-click on the map

component that precedes the segment you are creating and select either Create
Sub > Delimited Segment or Insert > Delimited Segment.
The system displays the NCPDP Delimited Segment Properties Dialog Box.

2. On the Name tab, type the segment name.

Note: If a segment occurs more than once in a map it is identified by its name
<ID>. The second and subsequent occurrences are identified by <ID>:n, where
n is the number of the occurrence in the map.

3. Type a description for the segment.
4. Click the Tag tab.
5. Enter the field identifier and segment identifier.
6. To use a key field, select the Key Field tab and complete the appropriate

fields.
7. If the segment is a looping structure, select the Looping tab. If it is not a

looping structure, accept the defaults and click OK.
8. Type the minimum amount of times the segment must repeat.

Note: If the Min Usage box contains a 0, the segment is conditional. If the
Min Usage box contains a 1 or greater, the segment is mandatory.

9. If required, enter the maximum number of times the segment can repeat.
10. Click OK to save changes to the segment.

How to Create a Positional Field
There are two ways to add positional fields to a map.
v If you have only one field to add, use the Create Sub function. See Creating

Positional Fields using the Create Sub Function for instructions.
v If you need to add multiple positional fields to a record, use the Positional Field

Editor. Create the fields for the first record, and then proceed with each
sequential record. See Creating Positional Fields using the Positional Field Editor
for instructions.

Creating Positional Fields using the Create Sub Function
About this task

Use this procedure to create a positional field in the NCPDP side of a map.

Procedure
1. Select the positional segment in which you intend to create a field.

The system displays the NCPDP Positional Field Properties Dialog Box.
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2. On the Name tab, type the name of the positional field.

Note: Do not use spaces or dashes in the Name box. You can use the
underscore symbol (_) to separate words.

3. To specify validation information for this field, click the Validation tab and
enter the information.

4. To specify an extended rule for this map component, click the Extended Rule
tab and enter the rule.

5. To specify a standard operation rule for this map component, click the
Standard Rule tab and enter the rule.

6. To set conditional relationships between this field and another positional field,
click the Conditions tab and set the conditions.

7. Click OK to save the properties for this field.

Creating Positional Fields using the Positional Field Editor
About this task

Use this procedure to create positional fields for a record.

Procedure
1. Right-click the positional segment and select Edit Fields.

The system displays the Positional Field Editor dialog box.
2. If this is the first field in the record, click New. Otherwise, highlight the field

that precedes the field you are creating in the record layout and click New.

Note: You need to fill in the field values in the Field Details section.
3. Type the field name.

Note:

v Each application field must have a unique name. It is useful to tag the end
of the fields that occur in multiple records with a suffix that identifies the
record that contains it.

v Do not use spaces or dashes (-) in the field name. You can use the
underscore (_) to separate words.

4. If required, select Mandatory.
5. Type a description of the field.
6. Select the data type for field.
7. Select the field format.

Note: The choices for this field depend on the type of field you selected from
the Data Type list. If you choose Number or Date/Time in the Data Type box,
you can select the data format from the Format list. If you selected String
from the Data Type box, you should type a syntax token to indicate that this
field must be formatted as the specified syntax token dictates. (The default
syntax token is X.)
See Field Format Values for more information on selecting your data format.

8. To indicate the exact position of the field in the record, type the starting
position of the field.

Note: You want to specify field start positions if, for example, you are using
only a few fields but you want them positioned exactly in the record. The
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alternative to specifying the start position of each field is to add the fields
sequentially in the record and then use the Auto Position function.

9. Type the minimum number of characters that is acceptable for this field.
10. Type the maximum length of the field.
11. Click New.

The system adds the field and creates a new field with blank values ready for
you to identify.

12. Create the rest of the fields according to your record layout.

Note: Click Delete to stop adding fields.
13. After adding the last field, if you want the system to automatically position

the fields in the record, click Auto Position.
This option automatically calculates the start position in the record of each
field. The system bases the start positions on the assumption that each field is
positioned directly after the previous field and is of the length specified in the
Max Length box. Click Yes to acknowledge the warning message that fields
are sequenced in order.

Important: Use the Auto Position function only if you define a record tag,
and if you define every field in the record in the sequence that each field
occurs. See the IBM Sterling Gentran:Server for Microsoft Windows Application
Integration User Guide for more information on defining record tags.

14. When you are finished adding fields to the record, click Close.
Repeat this procedure to add fields to the other records you defined.

Creating a Delimited Field
Each NCPDP delimited segment contains a group of logically-related data fields,
separated by the field delimiter character. This topic explains how to create a
delimited field.

About this task

Use this procedure to create a delimited field.

Procedure
1. Right-click the map object that precedes the delimited field you are creating

and select either Create Sub > Delimited Field or Insert > Delimited Field.
The system displays the NCPDP Delimited Field Properties Dialog Box.

2. On the Name tab, type the name and a description for the field.
3. On the Tag tab, do the following:

v Type the field identifier in the Field ID box.
v To designate that the order of this field is fixed, select Fixed Order.

4. On the Validation tab, do the following:
v If the is field mandatory, select Check here if this field is mandatory.
v Specify the minimum and maximum length of the element.

Note: If the data is less than the minimum length, the system generates a
compliance error during translation.

v Select the data type for the field.
v Select the data format for the field.
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Note: The choices for this field depend on the value you selected from the
Data Type list. If you choose Number or Date/Time in the Data Type box,
you can select the data format from the Format list. If you selected String
from the Data Type box, you should type a syntax token to denote that this
field must be formatted as the specified syntax token dictates. The default
syntax token is X. See Field Format Values for more information about data
formats.

5. To specify an extended rule for this field, click the Extended Rule tab and type
the extended rule.

6. To specify a standard operation rule for this field, click the Standard Rule tab
and type the standard rule.

7. To set conditional relationships between this field and another field, click the
Conditions tab and do the following:
v Select the conditional relationship.
v If the type of relationship is Conditional or List Conditional, select the first

field in the relationship from the Please select the condition field list.
v Select the fields that you want to use in the relationship from the Available

Fields list and click Add to add them to the Fields used in relationship list.
8. Click OK to save the changes.

About Repeating Fields
Repeating fields within a segment occur as logical groups and must be submitted
as a set. Only fields that are designated as repeating fields (looping fields) in the
NCPDP Telecommunication Standard can be repeated.

Count and counter fields identify repeating fields.
v A count field is used to specify the total number of repetitions of the fields in a

grouping. All repeating fields must have a count field that accompanies the
repeating field in the transaction.

v A counter field identifies a specific repeating loop in a series of loops, in
sequential order. It is synonymous with occurrence number. Counter fields may
occur multiple times with their associated repeating fields.
For example: In a repetition of four, the first occurrence of the field or set/logical
grouping is preceded by a counter field with a value of 1. The second occurrence
of that field or grouping is preceded by a counter with a value of 2.
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Example count field in map

This example shows a count field in an NCPDP map.

Example counter field in map

This example shows a counter field in an NCPDP map. This counter field has two
subfields. The second subfield is selected.

Creating a Count Field
Count and counter fields are repeating fields. A count field is used to specify the
total number of repetitions that follow the fields in a grouping.

About this task

Use this procedure to create a count field.

Procedure
1. Right-click the map object that precedes the delimited field you are creating

and select either Create Sub > Count Field or Insert > Count Field.
The system displays the NCPDP Count Field Properties dialog box.

2. O the Name tab, type the name of the field.
3. Type the description for the field and click OK.
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4. On the Tag tab, do the following:
a. Type the field identifier.
b. To specify that the order of this field is fixed, select Fixed Order.

Note: The NCPDP standard requires count fields to be in a fixed order.
c. Click OK.

5. On the Repeat tab, do the following:
a. Specify the minimum and maximum number of times that the field can

repeat. The default value for Maximum Usage is 1.
b. If this field is part of a loop, select Treat this field as a repeating field. This

option enables you to link this field to a field that is at a different nesting
level (one level up).

Note:

v Selecting this checkbox reduces the nesting level of the segments within
the group by one.

v When you link fields on the input side of your map to fields on the
output side, the Application Integration subsystem normally requires that
you link a single-occurring field to a field that is at the same level of
nesting. The "Treat this field as a repeating field" option allows you to
link fields that are in different nesting levels. If you do not select this
option, you must link this field to a field that is at the same nesting level.

6. Click OK to save the changes to the field.

Creating a Counter Field
Count and counter fields are repeating fields. A counter field identifies a specific
loop in a series of loops, in sequential order. Counter fields occur multiple times
with their associated repeating fields.

About this task

Use this procedure to create a counter field.

Procedure
1. Right-click the map object that precedes the delimited field you are creating

and select either Create Sub > Counter Field or Insert > Counter Field.
The system displays the NCPDP Counter Field Properties Dialog Box with the
Name tab selected.

2. O the Name tab, type the name of the field.
3. Type the description for the field and click OK.
4. On the Tag tab, do the following:

a. Type the field identifier.
b. To specify that the order of this field is fixed, select Fixed Order.

Note: The NCPDP standard requires count fields to be in a fixed order.
c. Click OK.

5. On the Repeat tab, do the following:
a. Specify the minimum and maximum number of times that the field can

repeat. The default value for Maximum Usage is 1.
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b. If this field is part of a loop, select Treat this field as a repeating field. This
option enables you to link this field to a field that is at a different nesting
level (one level up).

Note:

v Selecting this checkbox reduces the nesting level of the segments within
the group by one.

v When you link fields on the input side of your map to fields on the
output side, the Application Integration subsystem normally requires that
you link a single-occurring field to a field that is at the same level of
nesting. The "Treat this field as a repeating field" option allows you to
link fields that are in different nesting levels. If you do not select this
option, you must link this field to a field that is at the same nesting level.

6. Click OK to save the changes to the field.
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Chapter 5. Using Partner Editor with NCPDP

About Partner Editor
The Partner Editor allows you to define, edit, and delete all partner relationship
information for your company and all of your trading partners. Partner
relationships allow you to send and receive data to and from your trading
partners.

The Partner Editor also allows you to use an internal system partner (Internal
System User) to define your company to the system.

See the Trading Partners section in the IBM Sterling Gentran:Server for Microsoft
Windows User Guide for more information on using Partner Editor outside the
scope of the NCPDP standard.

A partner profile begins with a partner definition. The partner definition contains
the basic information that the system needs before you define the rest of the
partner profile. You need to create a partner definition for each partner with whom
you are going to exchange data.

To complete the partner profile, you need to define inbound and outbound
relationships for each partner with whom you are going to exchange data.

Process for defining a partner profile

The following table describes the partner profile creation process.

Stage Description

1 Create the partner definition. See Creating a NCPDP Partner Definition .

2 Create the inbound relationship. See About NCPDP Inbound Relationships .

3 Create the outbound relationship. See About NCPDP Outbound Relationships
.

4 To use a cross-reference or lookup table with the partner relationship to
supplement or convert data you enter or receive inbound, see the Creating
Tables section in the IBM Sterling Gentran:Server for Microsoft Windows User
Guide for more information.

5 To use locations to contain address- and contact-related information about the
partner, see the Creating Partner Locations section in the IBM Sterling
Gentran:Server for Microsoft Windows User Guide for more information.
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Partner Editor Browser
Partner Editor enables you to define, edit, and delete all partner information for
your company and all of your trading partners.

This diagram illustrates the Partner Editor browser.

This table describes the parts of the Partner Editor browser.

Part Function

Select a Partner Displays the list of partner profiles.

Copy Displays the Partner Copy dialog box, which allows you to copy a
partner profile.

Import Displays the Import File Select dialog box, which allows you to import
a partner profile.

Export Displays the Export File Build dialog box, which allows you to export a
partner profile.

Exit Exits the Partner Editor dialog box.

Edit Displays the Partner Definition (New/Edit) Dialog Box for the selected
partner.

New Displays the Partner Definition (New/Edit) Dialog Box, which allows
you to create a new partner definition.

Delete Removes the selected partner profile from the system.

Inbound Displays the Inbound Relationship Dialog Box for the selected partner.

Outbound Displays the Outbound Relationship Dialog Box for the selected partner.

Tables Displays the Partner Tables dialog box for the selected partner.

Locations Displays the Location Select dialog box for the selected partner.
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Partner Definition (New/Edit) Dialog Box
The Partner Definition dialog box enables you to create a new partner definition
and allows you to edit a previously defined partner definition.

This diagram illustrates the Partner Definition - New dialog box.

This table describes the parts of the Partner Definition dialog box.

Part Function

Profile ID Specifies a unique identifier for the selected partner.

Name Specifies a unique name for the partner.
Note: Make this name as descriptive as possible because this is the
name displayed in the partner selection list.

EDI Code Specifies the EDI identifier for this partner. The system uses this value
during inbound processing to select the correct trading partner
definition.

Application Code Specifies an application code used to identify this partner. The system
uses this value during outbound import processing to select the correct
trading partner definition.

Default Mailbox Specifies a default mailbox to use in identifying this partner for EDI
relationships.

Default E-mail
Address

Specifies a default e-mail address to use to identify this partner for EDI
relationships.

New Mailbox Displays the Create New Mailbox wizard, which allows you to create a
new mailbox.

Edit Mailbox Displays the Mailbox Properties dialog box, which allows you to edit
the mailbox.

Inbound Relationship Dialog Box
Inbound relationships define the parameters the system needs to receive a message
from a trading partner. The Inbound Relationship dialog box controls other
subordinate dialogs which allow you to define everything that is necessary to
establish the relationship.

You are required to specify exactly which message is to be received. You also
define which translation objects are used to define any turnaround messages,
export rules, or printing requirements.
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This diagram illustrates the Inbound Relationship dialog box with the Advanced
options appended.

This table describes the parts of the Inbound Relationship dialog box.

Part Function

Relationship
Description

Specifies the existing inbound relationships.

Standard Specifies the standard to be used in this relationship.
Note: Only standards for which you have existing translation objects
are displayed. This box cannot be changed for an existing
relationship. Selection of this box is mandatory.

Valid values:

v A - TRADACOMS

v B - OTHER

v C - CII

v D - NCPDP

v E - EDIFACT

v M - OTHER

v O - ODETTE

v R - ROSETTANET

v T - TDCC

v U - UCS

v V - VDA

Version Specifies the standard version to be used in this relationship.
Note: Only versions of the selected standard for which you have
existing translation objects are displayed. If this box is changed for an
existing relationship, all of the information defined below it is cleared
and must be reselected. Selection of this box is mandatory.
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Part Function

Transaction Set Specifies the message to be used in this relationship.
Note: Only messages for the selected version (for which you have
existing translation objects) are displayed. If this box is changed for
an existing relationship, all of the information defined below it is
cleared and must be reselected. Selection of this box is mandatory.

Release Specifies the release number to be used in this relationship.
Note: Only releases for the selected message for which you have
existing translation objects are displayed. This box is currently only
used for messages defined in the TRADACOMS standard. Selection of
this box is mandatory for all TRADACOMS messages.

Transaction is an
Acknowledgement

Specifies that the transaction defined in this partner relationship is an
acknowledgement.
Note: If this checkbox is selected, the transaction is automatically
exported and reconciliation is performed using the exported data.

Groups Accesses the Inbound Group Select Dialog Box to configure the
group-level relationship information.

Interchanges Accesses the Inbound Interchange Select Dialog Box to configure the
interchange-level relationship information.

New Accesses the New Inbound Relationship dialog box, which allows you
to create a new relationship.

Delete Removes the specified inbound relationship from the system.

Translation Accesses the Inbound Translation Object Dialog Box.

Advanced Toggles the display of the advanced options.

Sequence Checking Specifies whether the system will use sequence checking and whether
that sequence checking is incremental or chronological. You can also
indicate that the system must check for duplicate control numbers.

v None - sequence checking will not be used

v Duplicate - check for duplicate control numbers
Note: Duplicate documents are not processed but outbound
receipts are still generated and sent.

v Incremental - the control number must be one greater than the last
number

v Chronological - the control number must be greater than the last
number

Last Used Control
Number

Specifies a value that is used to sequence check the next transaction
set control number or message reference. This value is replaced with
the sequence number of the last message received. This box is initially
set to zero.
Note: This box is inactive if Sequence Checking is NONE.

Duplicate
Documents

Indicates whether the system will check for duplicate message names.

Skip Compliance
Check

Indicates whether you want the system to compliance check the
messages for this relationship.
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Part Function

Generate
Acknowledgements

Instructs the system to generate a functional acknowledgement to this
trading partner when you receive the message defined in this
relationship. The default value for this box is No (do not generate an
acknowledgement).

v No - Do not generate acknowledgements

v Yes - No Error Detail: Generate acknowledgements without error
detail

v Yes - With Error Detail: Generate acknowledgements with error
detail

Note: This entire box is inactive if the message in this relationship is
an acknowledgement.

Test Indicator Specifies whether you want the system to treat the messages that you
receive from this trading partner as test or production.

Acknowledgement
Processing

Indicates whether acknowledgement reconciliation will occur during
the inbound break session (Immediate) or during its scheduled
interval (Deferred). The default is Deferred.

Inbound Translation Object Dialog Box
The Inbound Translation Objects dialog box is used to specify which translation
objects are used to process the data defined by this relationship.

This table describes the inbound translation levels (hierarchically, from the lowest
level up).

Part Function

Document Validate the message against the specified translation object to verify if
the message is compliant with the standard, and translate from the
message format to print or application format.

Transaction Remove the enveloping around a single message.

Group Remove the enveloping around a set of related messages (the messages
do not have to be the same type).

Interchange Remove the enveloping around groups that are destined for the same
trading partner.

This diagram illustrates the Inbound Translation Object dialog box with the
Advanced options appended.
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This table describes the parts of the Inbound Translation Object dialog box.

Part Function

Turn Around/Auto Displays all of the turnaround message options. When a message is
received, the turnaround message created is the natural response
message that contains as many elements from the received message
as possible.
Note: Click the Auto check box if you want the defined turnaround
process to be automatic. If the Auto box is deselected, the received
message will remain in the In Documents until it is selected for
processing.

Export File/Auto Displays all registered Export translation objects relative to the
Standard, Version, Transaction Set and Release defined by this
relationship. This allows you to specify that when a message is
received, it is exported into an output file.

v

– Click the Auto check box if you want the export file created
automatically upon receipt of the message. If the Auto box is
deselected, the received message will remain in the In
Documents until it is selected for processing.

– If the Export File Name is defined for this relationship, each
message is exported individually to a unique file. If you use
formatting characters in the file name, the message key changes
for each message that is exported, the Process ID stays the same
(for all messages exported from the same interchange), and the
unique ID changes.

See Export File Name for more information on these values.
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Part Function

Print Displays all of the print translation objects registered with the system
for the Standard, Version, Transaction Set, and Release defined by the
relationship. The selected translation object is used to print messages
received from this partner.

Export File Name Specifies the name of the file to be created or appended to as a result
of performing an export operation. This file name can contain a mix
of regular characters and formatting characters that are replaced by
the translator with the runtime value they represent.

Formatting characters supported:

%y (two-digit year)

%Y (four-digit year)

%m (abbreviated month name)

%M (month as a decimal number)

%d (abbreviated weekday name)

%D (day of the month as a decimal number)

%H (hour in 24-hour format)

%N (minutes)

%S (seconds)

%K (message key)

%P (process identifier)

%U (unique number derived using the current time, export filename,
process identifier, and the rand() function)
Note: The runtime file name is generated once per export.

This is an example of a runtime file name using formatting
characters:

d:\GENSRVNT\exports\dockey%Kprocid%Puniqueid%U.dat

Advanced Toggles the display of the advanced options.

Export to Mailbox Checking this box invokes the "Export to Mailbox" function, which
allows the output of an inbound translation to be delivered back to
the Mailbox Server Manager. This allows the Mailbox Server Manager
to act as a message broker to be responsible for delivering the data to
its final destination.
Note: If you specified the Export File Name, it is still valid and will
become the Attachment Filename. Formatting characters are still valid
for the filename and could cause multiple attachments to be created if
document key is used. For example, if the following filename is used
d:\gensrvnt\exports\dockey%Kprocid%Puniqueid%U.dat, this causes
a new attachment to be created for each document since the
document key creates a unique name for each document processed.

Use Partner Default
Mailbox and E-Mail
Address

Checking this box specifies that the output of the inbound translation
is exported to the default mailbox and E-mail address configured for
this partner.

Recipient Mailbox Contains a list of mailboxes so you can select the mailbox to which
the output of an inbound translation will be delivered.
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Part Function

New Mailbox Displays the Create New Mailbox wizard, which allows you to create
a new mailbox.

Recipient E-mail
Address

Contains the E-mail address to which the output of an inbound
translation will be delivered.

Edit Mailbox Displays the Create New Mailbox wizard, which allows you to edit
the mailbox.

Content
Type/SubType

Contains the content type/sub type of the message containing the
output of the inbound translation.

Application ID Specifies the application identifier that indicates the destination of the
messages.
Note: This value is not used for inbound.

Application Alias
Value

Contains (typically) the transaction set ID from the relationship.
Note: This value is used during the break process to identify a
relationship, but it is only used if the 5-key lookup fails (sender ID,
agency, version, test/production flag, and transaction set ID).

Import Not used for NCPDP.

Data Entry Not used for NCPDP.

Transaction Not used for NCPDP.

Acknowledge Contains other translation objects associated with the relationship,
giving you the capability to change the system behavior at the
message translation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as many
functions as required.
Note:

You will select a translation object from the Acknowledge list if you
have created a specific translation object for this relationship and if
you want to change the way the system behaves for this partner
relationship.

When the system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processes it. If you
need the system to process acknowledgements differently, you should
select an additional translation object from the Acknowledge list.

If the message is an acknowledgement and you choose an additional
Acknowledge translation object, the system will use the additional
translation object in place of the export translation object for
acknowledgement reconciliation.

Inbound Group Select Dialog Box
The Inbound Group Select dialog box is used to select an existing functional group
definition to be associated with this relationship. It can also be used to initiate the
definition of a new functional group or to modify or delete an existing definition.
The groups available to you are determined by the version you selected on the
Inbound Relationship dialog.

Note: Functional groups are optional for NCPDP.

This diagram illustrates the Inbound Group Select dialog box.
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This table describes the parts of the Inbound Group Select dialog box.

Part Function

Groups Displays all of the functional group definitions that are established for this
trading partner.

Select Selects the indicated functional group to be used with this relationship.
Note: Select <none> if the standard you are using does not require groups
and you do not want to use one.

New Displays the Inbound Group Entry Dialog Box, which allows you to create
a new group.

Edit Displays the Inbound Group Entry Dialog Box, which allows you to edit
the selected group.

Delete Removes the selected group from the system.

Inbound Group Entry Dialog Box
The Inbound Group Entry dialog box is used to specify a functional group
definition.

This diagram illustrates the Inbound Group Entry dialog box with the Advanced
options appended.

This table lists the describes of the Inbound Group Entry dialog box.
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Part Function

Description Contains the name of the functional group description.

Standard Displays the standard the system is using for this relationship
definition.

Version Displays the version of the standard the system is using for this
relationship.

Functional Group
ID

Defines the identification of the functional group specified. These
identification boxes are defined by the appropriate standard group to
categorize messages. The standard defines which functional group ID
should be used with each message type. This is a mandatory box.

Advanced Toggles the display of the advanced options.

Sequence
Checking

Specifies whether inbound sequence checking is used and whether the
type of sequence checking is incremental or chronological. You can also
indicate that the system must check for duplicate control numbers.

v None - sequence checking will not be used

v Duplicate - check for duplicate control numbers

v Incremental - the control number must be one greater than the last
number

v Chronological - the control number must be greater than the last
number

Note: If the system detects duplicate control numbers or detects
incremental or chronological control numbers that are out of sequence,
those messages are stored in the ?In Documents.

Last Used Group
Control Number

Specifies a value that the system will use to sequence check the group
control number. The number is replaced by the group control number
that the system receives. This value is initially set to zero.

Acknowledge
Group

Instructs the system to send a functional acknowledgement to this
trading partner when you receive the group defined in this
relationship. The default value for this box is deselected (do not expect
an acknowledgement).
Note: This check box is inactive if the message is an acknowledgement.

Ack Translation
Set ID

Contains the acknowledgement that you want generated for this group.

Group Transl.
Obj.

Not used for NCPDP.

Acknowledge
Transl. Obj.

Not used for NCPDP.

Inbound Interchange Select Dialog Box
The Inbound Interchange Select dialog box is used to select an existing interchange
definition to be associated with this relationship. You can also use it to initiate the
definition of a new interchange or to modify or delete an existing definition. The
interchanges available to you are determined by the version you selected on the
Inbound Relationships dialog. Interchanges are optional for NCPDP.

This diagram illustrates the Inbound Interchange Select dialog box.
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This table describes the parts of the Inbound Interchange Select dialog box.

Part Function

Interchanges Displays all of the Interchange definitions that have been established for
this trading partner.

Select Selects the indicated interchange to be used with this relationship.
Note: Select <none> if the standard you are using does not require
interchanges and you do not want to use one.

New Displays the Inbound Interchange Entry Dialog Box, which allows you to
create a new interchange.

Edit Displays the Inbound Interchange Entry Dialog Box, which allows you to
edit the selected interchange.

Delete Removes the selected interchange from the system.

Inbound Interchange Entry Dialog Box
The Inbound Interchange Entry dialog box is used to specify a new interchange
definition.

This diagram illustrates the Inbound Interchange Entry dialog box with the
Advanced options appended.
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This table describes the parts of the Inbound Interchange Entry dialog box.

Part Function

Description Contains the name of the interchange description.

Standard Displays the standard the system is using for this relationship definition.

Version Displays the version of the standard the system is using for this
relationship.

Interchange ID Defines the type of interchange you specified. The standard defines which
interchange ID should be used with each standard. This is a mandatory
box.

Advanced Toggles the display of the advanced options.

Sequence
Checking

Specifies whether or not the system will use sequence checking and
whether the sequence checking is incremental or chronological. You can
also indicate that the system must check for duplicate control numbers.

v None - sequence checking will not be used

v Duplicate - check for duplicate control numbers

v Incremental - the control number must be one greater than the last
number

v Chronological - the control number must be greater than the last
number

Note: If the system detects duplicate control numbers or detects
incremental or chronological control numbers that are out of sequence,
those messages are stored in the ?In Documents.

Last Used
Control
Number

Specifies a value that is used to sequence check the next interchange
control number. The number is replaced by the control number on the last
interchange received. This box is initially set to zero.
Note: This box is inactive if Sequence Checking is NONE.

Acknowledge
Interchange

Instructs the system to send a functional acknowledgement to this trading
partner when you receive the interchange set defined in this relationship.
The default value for this box is deselected (do not expect an
acknowledgement).

Ack
Translation Set
ID

Specifies the acknowledgement that you want the system to generate for
this interchange.

Interchange
Transl. Obj.

Not used for NCPDP.

Acknowledge
Transl. Obj.

Not used for NCPDP.

Outbound Relationship Dialog Box
Outbound relationships define the parameters needed to send a message to a
trading partner. The Outbound Relationship dialog box controls other subordinate
dialogs which allow you to define everything that is necessary to establish the
relationship.

You are required to specify exactly which message the system sends. You must also
specify which translation objects are used to define the data entry formatting,
import rules, or printing requirements. In addition, for NCPDP you need to define
the specific enveloping requirements that you agreed on with your trading partner.
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This diagram illustrates the Outbound Relationship dialog box with the Advanced
options appended.

This table describes the parts of the Outbound Relationship dialog box.

Part Function

Relationship
Description

Indicates the relationship description.

Standard Specifies the standard to be used in this relationship.
Note: Only standards for which you have existing translation objects
are displayed. This box cannot be changed for an existing
relationship. Selection of this box is mandatory.

Valid values:

v A - TRADACOMS

v B - OTHER

v C - CII

v D - NCPDP

v E - EDIFACT

v M - OTHER

v O - ODETTE

v R - ROSETTANET

v T - TDCC

v U - UCS

v V - VDA

Version Specifies the standard version to be used in this relationship.
Note: Only versions of the selected standard for which you have
existing translation objects are displayed. If this box is changed for an
existing relationship, all of the information defined below it is cleared
and must be reselected. Selection of this box is mandatory.
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Part Function

Transaction Set Specifies the message to be used in this relationship.
Note: Only transaction sets for the selected version (for which you
have existing translation objects) are displayed. If this box is changed
for an existing relationship, all of the information defined below it is
cleared and must be reselected. Selection of this box is mandatory.

Release Specifies the release number to be used in this relationship.
Note: Only releases for the selected message for which you have
existing translation objects are displayed. This box is currently only
used for messages defined in the TRADACOMS standard. Selection of
this box is mandatory for all TRADACOMS messages.

Groups Accesses the Outbound Group Select Dialog Box.

Interchanges Accesses the Outbound Interchange Select Dialog Box.

New Accesses the New Outbound Relationship dialog box, which allows
you to create a new relationship.

Delete Removes the specified outbound relationship from the system.

Translation Accesses the Outbound Translation Object Dialog Box.

Envelope Accesses one of the Outbound Envelope dialog boxes below,
depending on which version you specified.

v Outbound UNH Envelope

v Outbound MHD Envelope

v Outbound ST Envelope

v Outbound Generic Envelope

Advanced Toggles the display of the advanced options.

Last Used Control
Number

Specifies a value that is used to generate the next transaction set
control number or message reference. The number that is generated
will always be one more than the number in this box. Initially, this
box is set to zero.

Expect
Acknowledgement

Instructs the system to expect a functional acknowledgement to be
received from this trading partner as a result of your partner
receiving the message defined in this relationship. The default value
for this box is deselected (do not expect an acknowledgement).

Hours Overdue Defines how many hours must elapse before an expected functional
acknowledgement is considered overdue. This box is only valid if the
Expect Acknowledgement box is selected. The default value for this
box is “48,” indicating that the acknowledgement is considered
overdue in two days. If you enter a value of zero in this box, the
acknowledgement is immediately considered overdue.
Note: This box is inactive if Expect Acknowledgement is deselected.

Duplicate
Documents

Instructs the system to check for duplicate message names.
Note: This function checks for duplicate messages when messages are
imported manually into the Workspace. Duplicate messages remain in
the Workspace until they are deleted. If you try to move or post a
duplicate message, a warning message is displayed.

Test Indicator Defines whether this relationship definition is in test or production
status. The default value is production.

Outbound Translation Object Dialog Box
The Outbound Translation Objects dialog box is used to specify which translation
objects are used to process the data defined by this relationship.
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This table describes the outbound translation levels (hierarchically, starting with
the lowest level).

Part Function

Document Translate from import format or data entry to EDI.

Transaction Build the enveloping around a single message.

Group Build the enveloping around a set of related messages (the messages
do not have to be the same type).

Interchange Build the enveloping around groups that are destined for the same
trading partner.

This diagram illustrates the Outbound Translation Object dialog box with the
Advanced options appended.

This table describes the parts of the Outbound Translation Object dialog box.

Part Function

Import Displays all of the import translation objects that are in the system
for the Standard, Version, Transaction Set, and Release defined by
the relationship.

Print Displays all of the print translation objects that are in the system
for the Standard, Version, Transaction Set, and Release defined by
the relationship. The selected translation object is used to print
messages sent to this partner.

Data Entry Displays all of the screen entry translation objects that are in the
system for the Standard, Version, Transaction Set, and Release
defined by the relationship.

Advanced Toggles the display of the advanced options.

Application ID Defines the application identifier that indicates the destination of
the messages.
Note: This value is used only if the system import process uses a
3-key lookup.
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Part Function

Application Alias
Value

Defines criteria for this relationship definition, which is used
instead of another relationship definition, during the application
import function.
Note:

v This box will only be used if you receive translation objects that
are defined to use the Application Alias Value.

v This value is used only if the system import process uses a 3-key
lookup.

TurnAround Not used for NCPDP.

Export Not used for NCPDP.

Transaction Contains other translation objects associated with the relationship,
which gives you the capability to change the system behavior at
the message translation level. This allows you to use translation
objects that are as partner-specific as required and/or perform as
many functions as required.

You select a translation object from the Transaction list if you have
created a specific Transaction Build translation object for this
relationship and if you want to change the way the system behaves
for this partner relationship.

Acknowledge Not used for NCPDP.

Outbound Group Select Dialog Box
The Outbound Group Select dialog box is used to select an existing functional
group definition to be associated with this relationship. You can also use it to
initiate the definition of a new functional group or to modify or delete an existing
definition. The groups that are available to you are determined by the version you
selected on the Outbound Relationship dialog box.

Note: Functional groups are not specified for NCPDP.

This diagram illustrates the Outbound Group Select dialog box.

This table describes the parts of the Outbound Group Select dialog box.

Part Function

Groups Displays all of the functional group definitions that have been
established for this trading partner.
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Part Function

Select Selects the indicated functional group as the one the system uses
for this relationship.

New Displays the Outbound Group Entry Dialog Box, which allows you
to create a new group.

Edit Displays the Outbound Group Entry Dialog Box, which allows you
to edit the selected group.

Delete Removes the selected group from the system.

Outbound Group Entry Dialog Box
The Outbound Group Entry dialog box is used to specify a new functional group
definition.

This diagram illustrates the Outbound Group Entry dialog box with the Advanced
options appended.

This table describes the parts of the Outbound Group Entry dialog box.

Part Function

Description Contains the name of the functional group description.

Standard Displays the standard the system is using for this relationship
definition.

Version Displays the version of the standard the system is using for this
relationship.
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Part Function

Functional Group ID Defines the identification of the functional group being specified.
These identification boxes are defined by each appropriate
standards group to group like messages. The standard defines
which functional group ID should be used with each message
type. This is a mandatory box.

Envelope Accesses one of the Outbound Functional Group Envelope dialog
boxes below, depending on which version you specified on the
Outbound Relationship Dialog Box.

v Outbound GS Functional Group

v Outbound UNG Functional Group

v Outbound BAT Functional Group

Note: This button is inactive for NCPDP partner relationships.

Advanced Toggles the display of the advanced options.

Last Used Group
Control Number

Specifies a value that is used to generate the next interchange
control number. The number that is generated will always be one
more than the number in this box. This box will initially be set to
zero.
Note: To ensure that functional acknowledgements work correctly
you must define a unique control number for each group
relationship that exists for the same partner relationship.

Expect
Acknowledgement

Instructs the system to expect a functional acknowledgement to be
received from this trading partner as a result of your partner
receiving the group defined in this relationship. The default value
for this box is deselected (do not expect an acknowledgement).

Hours Overdue Defines how many hours must elapse before an expected
functional acknowledgement is considered overdue. This box is
only valid if the Expect Acknowledgement box is selected. The
default value for this box is “48,” indicating that the
acknowledgement is considered overdue in two days. If you enter
a value of “0” (zero) in this box, the acknowledgement is
immediately considered overdue.
Note: This box is inactive if Expect Acknowledgement is
deselected.

Sequence From Group Indicates whether the transaction set control number options for
this group setup should be controlled at the group level. If this
box is deselected, then the following boxes are inactive .

Last Used Control
Number

Specifies a value that is used to generate the next transaction set
control number for the sets defined within this functional group.
The number that is generated will always be one more than the
number in this box. This box will initially be set to zero.
Note: This box is inactive if Sequence From Group is deselected.
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Part Function

Format Specifies the format of the transaction set control number that is
generated.

v Normal The number is generated by incrementing the last used
control number. The length of the number is defined by the
standard.

v 6/3 The number is a composite of two numbers. The first six
digits are the last six digits of the functional group control
number. The last three digits are a counter beginning at “1”
within the functional group. Use this format only as instructed
by your trading partner.

v 5/4 The number is a composite of two numbers. The first five
digits are the last five digits of the functional group control
number. The last four digits are a counter beginning at “1”
within the functional group. This is the normal TDCC
numbering convention. It is used by the Motor, Rail, and Ocean
transportation industries.

v 5/3 The number is a composite of two numbers. The first five
digits are the last five digits of the functional group control
number. The last three digits are a counter beginning at “1”
within the functional group. This is the normal UCS convention,
which is used by the Grocery and Warehousing industries.

Note: This box is inactive if Sequence From Group is deselected.

Group Transl. Obj. Contains a partner-specific Group Build Map translation object if
this trading partner group deviates from the normal system
behavior. You will select a translation object from this list if you
want the system to perform partner-specific grouping.
Important: We strongly recommend that you do not change the
translation objects in the Group Transl. Obj. and Acknowledge
Transl. Obj. lists, unless you have a specific reason for doing so.

Acknowledge Transl.
Obj.

Not used for NCPDP.

Outbound Interchange Select Dialog Box
The Outbound Interchange Select dialog box is used to select an existing
interchange definition to be associated with this relationship. It can also be used to
initiate the definition of a new interchange, or to modify or delete an existing
definition. The interchanges available to you are determined by the version you
selected on the Outbound Relationship dialog box. Interchanges are required for
NCPDP.

Note: All outbound document relationships that are configured to use the same
interchange definition will be placed into the same interchange during the build
process.

This diagram illustrates the Outbound Interchange Select dialog box.
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This table describes the parts of the Outbound Interchange Select dialog box.

Part Function

Interchanges Displays all of the interchange definitions that have been established for
this trading partner.

Select Selects the indicated interchange to be used with this relationship.
Note: Select <none> if the standard you are using does not require
interchanges and you do not want to use one.

New Displays the Outbound Interchange Entry Dialog Box, which allows you
to create a new interchange.

Edit Displays the Outbound Interchange Entry Dialog Box, which allows you
to edit the selected interchange.

Delete Removes the selected interchange from the system.

Outbound Interchange Entry Dialog Box
The Outbound Interchange Entry dialog box is used to specify a new interchange
definition.

This diagram illustrates the Outbound Interchange Entry dialog box with the
Advanced options appended.
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This table describes the parts of the Outbound Interchange Entry dialog box.

Part Function

Description Contains the name of the interchange description.

Standard Displays the standard the system is using for this relationship
definition.

Version Displays the version of the standard the system is using for this
relationship.

Interchange ID Defines the type of interchange you specified. The standard defines
which interchange ID should be used with each standard. This is a
mandatory box.

Advanced Toggles the display of the advanced options.
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Part Function

Envelope Accesses one of the Outbound Interchange Envelope dialog boxes
below, depending on which version you specified on the Outbound
Relationship Dialog Box.

v Outbound ISA Envelope

v Outbound ICS Envelope

v Outbound BG Envelope

v Outbound UNB Envelope

v Outbound UNA Envelope

v Outbound STX Envelope

v Outbound VDA Envelope

v Outbound NCPDP Envelope

Use the default
Mailbox and
E-mail Address

Indicates that the system will use the default Mailbox and E-mail
address specified on the Partner Definition (New/Edit) Dialog Box
when sending this interchange.

Mailbox Specifies a mailbox to use to identify this partner for NCPDP
relationships.

E-mail Address Specifies the destination mailbox for this interchange.

New Mailbox Displays the Create New Mailbox wizard, which allows you to create
a new mailbox.

Edit Mailbox Displays the Mailbox Properties dialog box, which allows you to edit
the mailbox.

Content Type Defines the content type and subcontent type of the interchange.

Set Max Number
of Documents per
Interchange

Instructs the system to only allow the specified maximum number of
messages per interchange for this relationship.

Max Number of
Documents per
Interchange

Specifies the maximum number of messages allowed per interchange
for this relationship.

Last Used Control
Number

Specifies a value that is used to generate the next interchange control
number. The number that is generated is always one more than the
number in this box. Initially, this box is set to zero.

Expect
Acknowledgement

Instructs the system to expect a functional acknowledgement to be
received from this trading partner as a result of your partner receiving
the interchange set defined in this relationship. The default value for
this box is deselected (do not expect an acknowledgement).

Hours Overdue Defines how many hours must elapse before an expected functional
acknowledgement is considered overdue. This box is only valid if the
Expect Acknowledgement box is selected. The default value for this
box is “48,” indicating that the acknowledgement is considered
overdue in two days. If you enter a value of zero in this box, the
acknowledgement is immediately considered overdue.
Note: This box is inactive if Expect Acknowledgement is deselected.

Interchange Transl.
Obj.

Allows you to select a partner-specific Interchange Build Map
translation object if this trading partner interchange deviates from the
normal system behavior. You will select a translation object from this
list if you want the system to perform partner-specific interchanging.
Important: We strongly recommend that you do not change the
translation objects in this list, unless you have a specific reason for
doing so.

Acknowledge
Transl. Obj.

Not used for NCPDP.
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Outbound NCPDP Envelope Dialog Box
The Outbound NCPDP Envelope enables you to specify outbound parameters for
the NCPDP standard. The translator uses this information during the build process
to generate batch segments.

This diagram illustrates the Outbound Envelope NCPDP Envelope dialog box.

This table describes the parts of the Outbound NCPDP Envelope dialog box.

Part Function

Transmission
Type

Identifies whether the transmission is a Transaction or Response.

Sender ID Specifies the sender identifier defined by the processor/switch.

Batch Number Specifies the number of the batch, which matches the trailer record and
is assigned by the sender.

File Type Specifies whether the file is Production or Test.

Version/Release
Number

Specifies the version/release number of the header data.

Receiver ID Specifies the sender identifier defined by the processor.

Creating an NCPDP Partner Definition
The partner definition contains the basic information about that partner that the
system needs before you define the rest of the partner profile.

Before you begin

Before setting up a new partner definition, you must have the following
information.
v The communication profile name you use to communicate with this partner.
v The EDI code for this partner.
v The application code used to identify this partner in the import file. This

application code is needed only if the messages are processed using the file
Import facility.

About this task

Use this procedure to create a new partner definition.
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Procedure
1. Select Tools > Partner Editor.

The system displays the Partner Editor Dialog Box.
2. Click New.

The system displays the Partner Definition dialog box.
3. Type a unique alphanumeric Profile ID for this partner.

Note: You may not use special characters.
4. Type the partner name.
5. Type the EDI identifier for this partner.

Note: The system uses this identifier during inbound processing, to select the
correct partner. This correlates to the Sender ID in the Inbound Interchange.

6. If necessary, type an application code to identify this partner.

Note: The system uses this identifier during outbound import processing, to
select the correct partner.

7. Click Save.
8. Click Exit to return to the Partner Editor dialog box.

Note: To complete the partner profile you need to define an inbound and
outbound relationship for this partner.

About NCPDP Inbound Relationships
To correctly receive and process information from a trading partner, you must have
an appropriate inbound relationship established that defines the parameters
needed to receive data files from that partner. Each inbound relationship defines
which business messages are received from a partner.

You must set up several parameters that are used to create an inbound
relationship. These parameters tell the system the following information:
v The type of data which is received.
v The criteria the system uses to validate the information it receives.
v The functional groups and interchanges in which you expect to receive the

messages.
v Which receipt acknowledgement translation object should be used.

Translation objects

Each inbound relationship must have one or more associated inbound translation
objects. These translation objects determine how the received data is processed.
You need to specify which translation objects are used to define the rules for
exporting, printing, and creating turnaround messages. At a minimum, one
translation object must be available.

Note: If this relationship requires a new translation object, you must register that
translation object with the system before creating the inbound relationship. See the
Registering Translation Objects section in the Sterling Gentran:Server User Guide for
instructions on how to register translation objects.
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Inbound groups and interchanges

For NCPDP, you must define or select an inbound interchange and inbound
functional group before the system allows you to complete the setup of an
inbound relationship. The inbound functional group defines the format of the
functional group and the parameters that should be used to verify it. The inbound
interchange defines the format of the interchange and the parameters that should
be used to verify it.

Note: If you do not want to use an optional functional group or interchange you
must still select <none> from the appropriate dialog box to alert the system that
you are not using a group.

Before you begin

Before setting up an inbound relationship, you must know the following
information to plan the implementation of this partner:
v The standard that you expect from this trading partner (for example, NCPDP).
v The standard version that you expect from this trading partner (for example, 5.1

for NCPDP).
v The code for the message you expect from this trading partner (for example,

Purchase Order Request).
v The type of functional group and interchange the message is wrapped in when

it is received from this partner.

Process overview

The process you use when defining an inbound relationship is explained in the
following table.

Stage Description

1 Create a new inbound relationship.

2 Select at least one inbound translation object.

3 Create and select at least one inbound group to define how the message is
received from this partner.

4 Create and select at least one inbound interchange to define how the message
is received from this partner.

5 Set up the corresponding outbound relationship to generate the
acknowledgements your partner requests.

Creating an Inbound Relationship
About this task

Use this procedure to create an inbound relationship.

Procedure
1. Select Tools > Partner Editor.

The system displays the Partner Editor Dialog Box.
2. Select the partner profile for which you want to create an inbound relationship

and click Inbound.

Note: You must have already created a partner definition for this partner.
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The system displays the Inbound Relationship Dialog Box.
3. Click New.

The system displays the New Inbound Relationship dialog box.
4. In the description box, type a unique relationship name and click Save.
5. From the appropriate drop-down lists on the Inbound Relationship dialog box,

select the following:
v Standard (D - NCPDP)
v Version
v Transaction Set

Note: The information required for this dialog box should be provided to you
by your trading partner when this partner defines the details of the messages
they send you.

6. To define parameters to comply with the processing needs of your partner
(such as Sequence Checking, Last Used Control, Duplicate Documents, or
Generate Acknowledgement), click Advanced.
This extends the Inbound Relationship dialog box.

Selecting an Inbound Translation Object
About this task

Use this procedure to select an inbound interchange.

Procedure
1. On the Inbound Relationship dialog box, click Translation.

The system displays the Inbound Translation Object Dialog Box.
2. From the drop-down lists, select the translation objects that are required for this

inbound relationship from the lists.

Note: The lists display all the translation objects that are registered in the
system that are appropriate for the type of translation object (for example,
Export or Print) and the message.

3. If there are no translation objects displayed in the drop-down lists, no
translation objects of that type are registered for the correct version of the
message defined in the relationship.

4. If you selected an Export File translation object and you want to export to a
specific file, type the universal naming convention (UNC) name of that file in
the Export File Name box.

5. Click Save to save your selections and return to the Inbound Relationship
dialog box.

Selecting an Inbound Interchange
About this task

Use this procedure to select an inbound interchange.

Procedure
1. On the Inbound Relationship dialog box, click Interchanges.

The system displays the Inbound Interchange Select Dialog Box.
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2. If the required interchange is in the Interchanges list, select the interchange and
click Select. Continue with the Finalizing the Inbound Relationship task.
Otherwise, continue with step 3 to create the interchange.

3. On the Inbound Interchange Select dialog box, click New.
The system displays the Inbound Interchange Entry Dialog Box.

4. In the Description box, type the interchange description.
5. In the Interchange ID box, type the identification of the interchange you are

specifying.

Note: Your standards group defines which interchange ID should be used for
each type of message.

6. Click Advanced to display the full list of interchange setup options.
7. From the Acknowledge Transl.Obj. list, select the appropriate receipt

acknowledgement map and click Save.
The system stores the information and return to the Inbound Interchange Select
dialog box.

8. Highlight the new interchange and click Select.

Finalizing the Inbound Relationship
About this task

Use this procedure to finalize the inbound relationship.

Procedure
1. On the Inbound Relationship dialog box, click Save.
2. Click Exit to return to the Partner Editor dialog box.

About NCPDP Outbound Relationships
To correctly send information to a trading partner, you need to define an outbound
relationship. Outbound relationships define the parameters needed to send a data
file to a trading partner. Each outbound relationship defines the format of a single
business message, and how that business message is formatted and sent to the
specified trading partner.

You must set up several parameters that are used to create an outbound
relationship. These parameters tell the system the following information:
v How to create the required message.
v The criteria that the system uses to validate the information entered.
v How to create the interchange envelope in preparation for sending.

Translation objects

Each outbound relationship must have one or more associated outbound
translation objects. These translation objects determine how the sent data is
formatted. You need to specify which translation objects are used to define the
rules for screen entry or file import. At a minimum, one translation object must be
available.

Note: If this relationship requires a new translation object, you must register that
translation object with the system before creating the outbound relationship. See
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the Registering Translation Objects section in the Sterling Gentran:Server User Guide
for instructions on how to register translation objects.

Outbound groups and interchanges

For NCPDP, you must define or select an outbound interchange and outbound
functional group before the system allows you to complete the setup of an
outbound relationship. The outbound functional group defines the format of the
functional group and the parameters that should be used to verify it. The
outbound interchange defines the format of the interchange and the parameters
that should be used to verify it.

Note: If you do not want to use an optional functional group or interchange you
must still select <none> from the appropriate dialog box to alert the system that
you are not using a group.

Before you begin

Before setting up an outbound relationship, you must know the following
information to plan the implementation of this partner:
v The standard that you expect from this trading partner (for example, NCPDP).
v The standard version that you expect from this trading partner (for example, 5.1

for NCPDP).
v The code for the message you expect from this trading partner (for example,

Purchase Order Request).
v The type of functional group and interchange the message is wrapped in when

it is sent to this partner.

Process overview

The process you use when defining an outbound relationship is explained in the
following table.

Stage Description

1 Create a new outbound relationship.

2 Select at least one outbound translation object.

3 Create and select at least one outbound interchange to define how the
message is received from this partner.

4 If you are using the NCPDP standard, complete the Outbound NCPDP
Envelope Dialog Box at the interchange level.

5 If you have not done so already, set up the corresponding inbound
relationship to receive the acknowledgements you expect from your partner.

Creating an Outbound Relationship
About this task

Use this procedure to create an outbound relationship.

Procedure
1. Select Tools > Partner Editor.

The system displays the Partner Editor Dialog Box.
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2. Select the partner profile for which you want to create an outbound
relationship and click Outbound.

Note: You must have already created a partner definition for this partner.
The system displays the Outbound Relationship Dialog Box.

3. Click New.
The system displays the New Outbound Relationship dialog box.

4. In the description box, type a unique relationship name.
5. Click Save.

The system creates a new outbound relationship and returns to the Outbound
Relationship dialog box.

6. From the appropriate drop-down lists on the Outbound Relationship dialog
box, select the following:
v Standard (D - NCPDP)
v Version
v Transaction Set

Note: The information required for this dialog box should be provided to you
by your trading partner when this partner defines the details of the messages
they send you.

7. If you need to define parameters to comply with the processing needs of your
partner (for example, Last Used Control Number, Expect Acknowledgement,
Hours Overdue, Duplicate Documents, or Test Indicator), click Advanced.
This extends the Outbound Relationship dialog box.

Selecting an Outbound Translation Object
About this task

Use this procedure to create an outbound relationship.

Procedure
1. On the Outbound Relationship dialog box, click Translation.

The system displays the Outbound Translation Object Dialog Box.
2. From the drop-down lists, select the translation objects that are required for this

outbound relationship from the lists.

Note: The lists display all the translation objects that are registered in the
system that are appropriate for the type of translation object (for example,
Import or Print) and the message. If there are no translation objects displayed
in the drop-down lists, no translation objects of that type are registered for the
correct version of the message defined in the relationship.

3. If you selected an Import translation object, you may need to define the
following if your import process uses a 3-key lookup:
v In the Application ID box, type the application identifier that indicates the

destination for the messages.
v In the Application Alias Value box, type criteria that the system will use to

distinguish this relationship from others during the application import
function.

4. Click Save to save your selections and return to the Outbound Relationship
dialog box.
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Selecting an Outbound Interchange
About this task

Use this procedure to create an outbound relationship.

Procedure
1. On the Outbound Relationship dialog box, click Interchanges to display a list

of existing interchanges.
The system displays the Outbound Interchange Select Dialog Box.

2. If the required interchange is in the Interchanges list, select the interchange
and click Select. Continue with “Finalizing the Outbound Relationship.”
Otherwise, continue with step 3 to create the interchange.

3. On the Outbound Interchange Select dialog box, click New.
The system displays the Outbound Interchange Entry Dialog Box.

4. In the Description box, type the interchange description.
5. In the Interchange ID box, type the identification of the interchange you are

specifying.
Your standards group defines which interchange ID should be used for each
type of message.

6. Click Advanced to display the full list of interchange setup options.
This extends the Outbound Interchange Entry dialog box.

7. To use the default mailbox and e-mail address, continue with step 9.
Otherwise, either select the appropriate mailbox or click New Mailbox to
create a new mailbox.
See the IBM Sterling Gentran:Server for Microsoft Windows Communications User
Guide for more information on creating mailboxes.

8. From the Interchange Transl. Obj. list, select the appropriate build translation
object and click Save.
The system stores the information and returns to the Outbound Interchange
Entry dialog box.

9. Click Envelope to set up the parameters for the generation of the interchange
segment.
The system displays the Outbound NCPDP Envelope Dialog Box.

10. After you set up the required parameters in the enveloping dialog box, click
Save to store the information and return to the Outbound Interchange Entry
dialog box.

11. Click Save to store the information on the Outbound Interchange Entry dialog
box and return to the Outbound Interchange Select dialog box.

12. Highlight the new interchange and click Select to return to the Outbound
Relationship dialog box.

Finalizing the Outbound Relationship
About this task

Use this procedure to create an outbound relationship.

Procedure
1. On the Outbound Relationship dialog box, click Save to save the outbound

relationship.
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2. Click Exit to return to the Partner Editor dialog box.

Editing an NCPDP Partner Definition
The partner definition contains the basic profile information about that partner to
which the system associates the rest of that partner’s records. You can edit the
partner definition from the Partner Editor dialog box.

About this task

Use this procedure to edit a partner profile.

Procedure
1. Select Tools > Partner Editor.

The system displays the Partner Editor Dialog Box.
2. Select the appropriate partner from the Select a Partner list and click Edit.

The system displays the Partner Definition (New/Edit) Dialog Box for that
partner.

3. Make the necessary changes and click Save.

Note: You can also edit other aspects of a partner relationship (such as
inbound relationship, outbound relationship) by clicking the appropriate button
(Inbound or Outbound) on the Partner Editor dialog box. You are not able to
edit any boxes that are unavailable; these are the "keys" to the relationship. In
this case, you must create a new inbound or outbound relationship for that
partner.

Deleting a Partner Profile
The partner definition contains the basic profile information about that partner to
which the system associates the rest of that partner’s records. You can delete the
partner definition from the Partner Editor dialog box.

About this task

Use this procedure to delete a partner profile.

Procedure
1. Select Tools > Partner Editor.

The system displays the Partner Editor Dialog Box.
2. Select the appropriate partner and click Delete.

You are prompted to confirm the deletion.

Important: When you delete a partner relationship, the messages and
interchanges associated with that partner are also deleted. If any messages or
interchanges exist for a partner you choose to delete, you are warned before the
actual deletion.

3. Click Yes to delete the selected partner profile.
The partner profile and all associated records are deleted.
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Chapter 6. Batch Transaction Set Schematics

Batch Transaction Header
Record

Format: fixed-length (non-delimited)

Length: 75 characters

Segment ID: 2-characters (00)

Field Field Name Type Length
Key
Field Value

880-K4 Text Indicator A/N 1 Start of text (STX) = X’02’

701 Segment Identifier A/N 2 00

880-K6 Transmission Type A/N 1 v T = Transaction

v R = Response

v E = Error

880-K1 Sender ID A/N 24 Yes Defined by processor or switch

806-5C Batch Number N 7 Number that the sender assigns. Matches Batch
Number in Trailer. To be returned in Response
or Error file from processor/switch

880-K2 Creation Date N 8 Format = CCYYMMDD

880-K3 Creation Time N 4 Format = HHMM

702 File Type A/N 1 v P = Production

v T = Test

102-A2 Version/Release
Number

A/N 2 Version/release number of Header data

880-K7 Receiver ID A/N 24 Yes Identifier defined by processor or switch

880-K4 Text Indicator A/N 1 End of text (ETX)-X’03’

Batch Detail Data Record
Record

Format: variable-length (contains both fixed- and variable-length fields)

Segment ID: 2-character segment ID (G1)

Field Field Name Type Length
Key
Field Value

880-K4 Text Indicator A/N 1 Start of text (STX) = X’02’

701 Segment Identifier A/N 2 G1

880-K5 Transmission
Reference Number

A/N 1 Reference number that the provider assigns to
the batch transmission

NCPDP Data Record Varies
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Field Field Name Type Length
Key
Field Value

880-K4 Text Indicator A/N 1 Yes End of text (ETX)-X’03’

Batch Trailer Record
Record

Format: fixed-length

Length: 56 characters

Segment ID: 2-character (99)

Field Field Name Type Length
Key
Field Value

880-K4 Text Indicator A/N 1 Start of text (STX) = X’02’

701 Segment Identifier A/N 2 99

806-5C Batch Number N 7 Number that the sender assigns to the batch.
Matches Batch Number in Header.

751 Record Count N 10 Total number of enrollment segments in the
entire file

504-F4 Message A/N 35 Free-form message

880-K4 Text Indicator A/N 1 Yes End of text (ETX)-X’03’

Request Transaction Header Segment
Record

Format: fixed-length

Length: 56 characters

Field Field Name Type Length
Key
Field Value

101-A1 BIN Number 9(6) 6 Card issuer ID or bank ID number used for
network routing.

102-A2 Version/Release# X(2) 2 Yes 01,03,31...51 (51 is version 5.1)

103-A3 Transaction Code X(2) 2 Yes E1, B1, B2, B3, C1, C2, C3, N1, N2, N3, P1, P2,
P3, P4

104-A4 Processor Control # X(10) 10 Control number assigned by the processor

109-A9 Transaction Count X(1) 1 Blank or 1, 2, 3, 4

202-B2 Service Provider ID
Qualifier

X(2) 2 Yes 01, 02, ..., 13, 14, 99 (07 is NCPDP Provider ID)

201-B1 Service Provider ID X(15) 15 Yes Pharmacy number or provider identifier

401-D1 Date of Service 9(8) 8 Format = CCYYMMDD

110-AK Software
Vendor/Certification
ID

X(10) 10 Identifier that the switch or processor assigns to
identify the software source
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Response Transaction Header Segment
Record

Format: fixed-length

Length: 31 characters

Field Field Name Type Length
Key
Field Value

102-A2 Version/Release# X(2) 2 Yes 01,03,31...51 (51 is version 5.1)

103-A3 Transaction Code X(2) 2 Yes E1, B1, B2, B3, C1, C2, C3, N1, N2, N3, P1, P2,
P3, P4

109-A9 Transaction Count X(1) 1 Blank or 1, 2, 3, 4

501-F1 Header Response
Status

X(1) 1 v A = Accept

v R = Reject

202-B2 Service Provider ID
Qualifier

X(2) 2 Yes 01, 02, ..., 13, 14, 99 (07 is NCPDP Provider ID)

201-B1 Service Provider ID X(15) 15 Yes Pharmacy number or provider identifier

401-D1 Date of Service 9(8) 8 Format = CCYYMMDD
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA 95141-1003

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.
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This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2012. Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. 2012.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.
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Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.
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